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Safety and approval information
This Rosemount product complies with all applicable European directives when properly installed in accordance with
the instructions in this manual. Refer to the EU Declaration of Conformity for directives that apply to this product. The
EU Declaration of Conformity, with all applicable European directives, and the complete ATEX installation drawings
and instructions are available on the Internet at Emerson.com/Global or through your local Emerson support center.
Information affixed to equipment that complies with the Pressure Equipment Directive can be found on the Internet
at Emerson.com/Global.
For hazardous installations in Europe, refer to standard EN 60079-14 if national standards do not apply.

Other information
Full product specifications can be found in the product data sheet. Troubleshooting information can be found in the
3812 Maintenance and Troubleshooting Manual (00809-0100-3812).
Product data sheets and manuals are available at Emerson.com/Global.

Return policy
Follow Emerson procedures when returning equipment.
These procedures ensure legal compliance with government transportation agencies and help provide a safe working
environment for Emerson employees. Emerson will not accept your returned equipment if you fail to follow Emerson
procedures. Return procedures and forms are available on our website at Emerson.com/Global.
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1  Start-up checklist
1.1  Checklist

During meter start-up, have the following equipment and information on hand:
Table 1-1: Meter start-up checklist

Site pipe and ID drawings with elevations
Site wiring diagrams
Rosemount Liquid Ultrasonic Meter calibration data
Rosemount Liquid Ultrasonic Meter manuals
Information and manuals for all other flow instrumentation - flow computers,
pressure and temperature transmitter data sheets, and wiring
Shutoff and control valve information, specifications, operation and setup data
Ethernet (Cat 5 cables) or serial cables to link the laptop to the meter
Field service representative's telephone numbers for major components: valves,
meter, flow computer, communication gear, transmitters, site designers or
integrators
Check all ultrasonic meter wiring.
Check the switch settings on transmitter CPU Module.
Start MeterLink™.
Establish flow in the meter (at least 4 ft/s to ensure good thermal mixing).
Save the meter configuration file - your As Found record of the meter. In MeterLink,
select Tools → Edit/Compare Configuration.
Click the Read button and select File Save.
Open File → Program Settings and customize MeterLink user preferences.
Open Meter → Monitor and check the measurement paths or chords and that they
agree with each other to approximately 0.2%.
Check for alarms, open Meter → Monitor and click Check Status.
Check signal strength
• Check for good signal strength (usually shown as “SNR”) or, Signal to Noise Ratio.
• Check for reasonably correct flow profile.

Go to Logs/Reports → Maintenance Logs/Reports to collect and save a Maintenance
Log to record the initial performance of your meter (this is your As Found record).
From the Meter → Field Setup Wizard menu, make any configuration adjustments,
such as setting the frequency and digital output variables, frequency full scale,
analog outputs, local display configuration and temperature and pressure analog
inputs scaling and alarm limits.
Save another Maintenance Log (this is your As Left record).
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1.2  Cybersecurity and network communications
In order to mitigate cybersecurity risks, configure the 3810 electronics TCP/IP
communications as follows:

1. MeterLink™ uses either FTP or HTTP protocols for Archive and Smart Meter
Verification log collection. It is recommended to disable the FTP protocol and leave
the HTTP protocol enabled using the Meter → Communication Settings dialog in
MeterLink. Both can be disabled for additional security, but log collection will not be
possible in this configuration.

2. Leave the Telnet port disabled. This port is not required for any communications to
field devices or MeterLink. Beginning with Rosemount 3810 Series Firmware v1.60,
Telnet is permanently disabled.

3. Enabling the physical Write Protect switch will prevent metrology configuration
changes and firmware upgrades. It will also prevent enabling TCP/IP protocols such
as FTP, HTTP, and Telnet.

4. Disable unused protocols or set them to read-only if write capability is not required.
The Modbus TCP/IP protocol can be set to Read-only or Disabled on the Ethernet
port. Modbus protocols can be disabled or made read-only on serial ports while still
allowing authenticated MeterLink communications.

5. Rosemount 3810 Series Firmware v1.60 and later require user authentication and
has a default administrator password. While the password is unique to each meter,
it is highly recommended to be changed at meter start-up. For added security, the
default username, administrator, can be changed as well.

6. Other users can be added with different privileges and passwords in the Rosemount
3810 Series Firmware v1.60 and later. Only give users privileges to perform their
job functions. For more information, see Manage users on how to add, change, and
delete users.

This transmitter:
1. Is not intended to be directly connected to an enterprise or to an internet facing

network without a compensating control in place.
2. Must be installed following industry best practices for cybersecurity.

Start-up checklist Operations Manual
March 2025  00809-0200-3810

6 www.Emerson.com

https://www.emerson.com/global


2  Initial communication set up
2.1  Set up meter communications

After the installation of your Rosemount Ultrasonic Meter, install MeterLink™ on your PC
or laptop as described in the MeterLink Software for Gas and Liquid Ultrasonic Flow Meters
Quick Start Manual (00809-0100-7630) for your operating system, then configure the meter.
The MeterLink Software for Gas and Liquid Ultrasonic Flow Meters Quick Start Manual
(00809-0100-7630) is made available with the meter.
The MeterLink installation program is available for download from the Emerson website:
Emerson.com/meterlink.

2.1.1  MeterLink™ configuration utilities
MeterLink provides the following utilities to configure the meter’s flow measurement units,
meter output parameters, communications settings, output tests, waveforms, and logs and
reports file management:
Meter
• Connect
• Disconnect
• Monitor
• Field Setup Wizard

— Startup
— General
— Frequency/Digital Output Sources
— Frequency Outputs
— Meter Digital Outputs
— Analog Outputs
— HART® Outputs
— Meter Corrections
— Temperature and Pressure
— Alarm Limits
— Local Display

• Communications Settings
• Signal Analyzer
• Meter Information
• Manage Users
• Open Data Folder
• Tools

— Edit/Compare Configuration
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— Waveform Viewer
— Outputs Test
— Transducer Swap-Out
— Set Transducer Type
— Reset Tracking
— Reset Velocity Estimation
— Override Velocity Estimation Update Time
— Locate Meter
— Program Download
— Communications Analyzer
— Warm Start Meter

2.1.2  Set up the meter directory
Set up the connection properties for your meter.
By default, the meter directory contains only one record named New Meter, which is
defaulted to connect to a Rosemount Liquid Ultrasonic Meter configured as shipped from
the factory.

2.1.3  Create a new meter record
Procedure

1. Select Insert, Insert Duplicate, or Add from the File dropdown list to create a new
record.

2. Set up the record by entering a Short Desc, Meter Type, and selecting the
connection type(s) checkboxes: Direct, Modem, Ethernet.
For each connection type selected, a button will be enabled at the bottom of the
dialog with the same name.

3. Click these buttons to edit the connection properties for that connection method.
4. After choosing the connection properties, click OK to accept the changes or click

Cancel to discard any changes and close the dialog.

2.1.4  Set up a direct connection
Procedure

1. Connect to the meter directly through one of the serial ports on the meter using one
of the serial ports on your computer.

2. Click Direct to set the following parameters.
Protocol TCP/IP is a read-only field and is the only protocol MeterLink™ uses.

Note
Rosemount Ultrasonic meters still support Modbus® ASCII and
Modbus remote terminal unit (RTU) when talking to other
applications or devices.
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Comms
Address

Enter the communication address that is configured in the meter
hardware. The default address for meters from the factory is 32. For
Rosemount Ultrasonic meters, the valid range is from 1 to 247.

Port Select the available driver from the list of those installed on your
machine.

Baud Rate Select the serial port baud rate from the dropdown list for which the
meter hardware is configured. The default Baud Rates is 19200.

2.1.5  Modem connection
Set the following properties to connect to the meter via a modem:
Protocol and
Comms
Address

Use the Protocol and Comms Address parameters in Set up a direct
connection.

Modem Select the modem to use from the dropdown list. Only modems installed in
Windows® show in the dropdown list. If the dropdown list is blank, then no
modems have been installed for Windows®.
Note
Do not select Direct Connection or Communications cable between two
computers for the modem. This is a NULL modem driver for direct
connection to Rosemount Ultrasonic meters only. It will not work for the
Modem connection.
MeterLink™ uses the Microsoft® Dial-up Networking for making modem and
direct serial connections to a meter. Click Modem Properties to bring up
the Dial-up networking entry MeterLink has created for this meter. Most of
the information required is set up correctly by MeterLink.

Baud Rate Select the desired Baud Rate from the dropdown list.
Telephone # Enter the telephone number for the modem to which the meter is

connected. Include digits to obtain to an outside line, if necessary. Inserting
commas between the digits pauses the dialing rate. Each comma is
approximately equal to two seconds.

Modem
Properties

Configures the properties associated with the modem.
MeterLink uses the Microsoft® Dial-up Networking for making modem and
direct serial connections to a meter. Click Modem Properties to bring up
the Dial-up networking entry MeterLink has created for this meter. Most of
the information required is setup correctly by MeterLink. Click OK to accept
the changes or click Cancel to discard any changes and return to the Meter
Directory dialog box.

2.1.6  Ethernet connection
Set the following properties to configure the Rosemount ultrasonic meter hardware for
Ethernet connectivity. Use the Direct, Modem, Ethernet and Ethernet 2 checkboxes for the
desired communications methods.
Note
It is strongly recommended that the meter be configured using an independent (off-
network) single host computer. After configuration of the meter, the DHCP option should
be disabled.
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IP Address Enter the IP Address for the meter’s Ethernet port.
The factory set IP Address is 172.16.17.200 for Rosemount Liquid
Ultrasonic meters or you can use 192.168.135.100 if DHCP is enabled
in the meter (see Dynamic Host Configuration Protocol (DHCP) for more
details).

Dynamic Host
Configuration
Protocol (DHCP)

Business PCs are usually configured to work in a network environment
where a DHCP server assigns an IP address to each computer when they
connect to the network.
If a PC is configured to obtain an IP address from a DHCP server and
it is going to connect through the Ethernet Cable (P/N 1-360-01-596) to
a Rosemount Ultrasonic meter that is not connected to a network, then
the DHCP server in the meter must be enabled so it can assign an IP
address to the PC when it connects.
The DHCP server can be enabled on the meter by setting the DHCP
switch on the central processing unit (CPU) module to the ON position.
When connecting to a meter with DHCP enabled, use the IP address
of 192.168.135.100 to connect to the meter. In this mode you can
create just one Meter Directory record with this IP address to connect to
all your meters with DHCP enabled. When the connection is made, select
to use the Meter Name in the meter instead of the Meter Directory
Name in order to keep all log files and configurations separate from
each meter.
Click OK to accept the changes or click Cancel to discard any changes
and return to the Meter Directory dialog box.

2.1.7  Ethernet initial connection steps
Procedure

1. Power up the meter.
2. Shut down the PC.
3. Plug the Ethernet adapter cable Phoenix end into the meter Field Connection Board

connector J8 and connect the RJ-45 end into the PC Ethernet connector.
4. Enable the Ethernet local area network (LAN) connector dynamic host configuration

protocol (DHCP) server on the central processing unit (CPU) module by moving the
DHCP (switch-1) to the ON position (see direction arrow on the CPU module label).

5. Power up (boot) the PC and log in to the initial Windows® login prompt.
6. Verify the Ethernet connection status by the CPU module LINK LED. The desired

color is solid green.
7. Launch MeterLink and create a new meter record.

2.2  Import a meter record
Procedure
Select File → Import from the Meter Directory dropdown list or click Import.
The Import Meter Directory File dialog opens. This will allow you to select a meter
directory .DAT file to import the file into the currently used meter directory file.
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If an identical meter record already exists and a duplicate is trying to be imported,
MeterLink™ inserts the duplicate meter record. The Import button performs the same
operation.

2.3  Export a meter record
Use the Export command to save the current meter directory to a file. Select File → Meter
Directory from the Meter Directory dropdown list or click Export.
Procedure

1. Enable the meter directory record checkbox you want to export or click Select All.
2. Click OK to begin exporting the meter record(s). Use the Export Meter Directory File

dialog to save the exported record to the default folder (C:\Ultrasonic Data) or
enter another location.

3. Click Save. If you have an existing METER_DIRECTORY_EXPORT.DAT file, you are
prompted to change the file name or replace the file. If changing the file name,
keep the .DAT extension to maintain functionality when importing the file to the new
machine.

4. Copy the exported file to the new machine.
5. Use the Import command to select this file and import it into the Meter Directory.

Important
Due to limitations in the Microsoft® Dial-Up Networking, not all of the
directory information for Direct and Modem connection can be exported to the
METER_DIRECTORY.DAT file for Rosemount Ultrasonic meters. MeterLink™ exports the
meter names, Comms Address, Interface, and Telephone numbers. It is necessary to
recheck the connection properties and verify the communication parameters such
as COM port, data bits, and parity are configured correctly.

2.4  Connect to the meter
Procedure

1. From the menu bar, select Meter → Connect or select the Connect icon  on the
toolbar.
The Connect to Meter dialog box displays a list of meters setup in MeterLink™.

2. Click either Direct or Ethernet next to the meter name to establish a connection with
your ultrasonic meter.
For Rosemount 3410 Series Firmware v1.60 and later, MeterLink will display a Meter
Login dialog box and require a valid username and password to be entered to make
a connection.
The default username for a meter from the factory or for a meter upgraded from
a firmware version prior to v1.60 is administrator. The default password is
Administrator-XXXXX where XXXXX is the non-zero padded central processing
unit (CPU) serial number, which can be found on a label on the CPU module.
MeterLink v1.90 or later is required to make a connection to a meter requiring user
authentication. See Meter → Manage Users for more details on setting up users,
user types, and passwords.
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2.5  Collect “As Found” logs and reports
Use the MeterLink™ Logs/Reports menu and collect and save the logs and reports for a
historical record of the meter at several velocities within the operating range of the meter
to establish a baseline to be used for the trending of the meter diagnostics and save the
following logs and reports for the “As Found” settings (factory default):
• Maintenance log
• System log
• Save your meter’s configuration file
• Use the Tools → Edit/Compare Configuration menu to display the dialog. Enable the

View All or Metrology radio button and click Read.
• The All view displays the meter’s extended configuration parameters. Grayed out values

are read-only, but help describe the configuration. The Metrology view displays the
path dimensions, pipe diameter, transducer delay parameters, zero flow calibration
coefficients, and flow calibration coefficients.
— Click the question mark icon for the data point to display additional information.

• Click Save to save the configuration file. By default, the file is saved to the Data folder
set up in File → Program Settings.

2.6  Customize MeterLink™ settings
Open MeterLink and access File → Program Settings, then input the desired settings for
your meter.
Your user name and company name is included on reports and logs generated with
MeterLink.

Initial communication set up Operations Manual
March 2025  00809-0200-3810

12 www.Emerson.com

https://www.emerson.com/global


Figure 2-1: Program settings

• User name
• Company name
• Data folder (where meter’s data is stored)
• Select the checkbox to create a subfolder with the meter’s name under Data folder for

saving and opening files for your meter
• Display units (of measurement); U.S. Customary or Metric for necessary unit

conversions read by the meter
• Meter volume units: gal, cubic feet, or bbl
• Prompt to save Meter Config (configuration) prompts you to save a copy of the meter

configuration after writing changes to the meter
• Run Connect dialog automatically after connecting
• Run Meter Monitor automatically after connecting
• Run Meter Monitor summary or detailed view after connecting
• Edit telephone number before connecting with a modem
• Use FTP passive mode (client - server pot communications)
• FTP-only connection - used to download firmware to Rosemount Ultrasonic meters
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• Tab from spreadsheet to next control instead of next cell
• TCP/IP meter connection database timeout - amount of time MeterLink waits to

respond to a request for data from the meter database (default 13 seconds)
• Override system default printer - used to change printer
• Product type preference - meter type you will most often connect, gas or liquid

2.7  Set up Modbus® communications
Rosemount 3810 Liquid Ultrasonic Flow Meters support RS-232 or RS-485 4-wire or 2-wire
half duplex serial interface to an external system (e.g., flow computer) using Modbus ASCII
protocol with the following parameters:
Table 2-1: Modbus communication parameters
Setting Value
Baud rate 19200
Data bits 7
Stop bits 1
Parity even
Protocol Modbus ASCII

Refer to your flow computer user manual to set input/output (I/O) settings required to
allow serial communication with the Rosemount 3810 Liquid Ultrasonic Flow Meters.
The Rosemount 3810 Liquid Ultrasonic Flow Meters support ASCII and RTU Modbus
communication. For ASCII Modbus, both 7E1 and 7O1 are supported. For RTU Modbus,
8N1 is supported. The communication ports provide automatic protocol detection - only
the baud rate and Modbus ID need to be specified. Also, refer to the Emerson website and
select the Product page for the model of your meter: Emerson.com/automation.
Set up Modbus TCP parameters
If the meter firmware supports Modbus TCP slave functionality, the following controls will
be available:
• Modbus TCP unit identifier: Enter the Modbus TCP unit identifier here. Valid values are

0-255.
• Enable alternate Modbus TCP port: The standard TCP port for Modbus TCP is port 502.

This port is always enabled in a meter that supports Modbus TCP. By selecting this
option, you can also enable Modbus TCP communications on a secondary TCP port
specified by Alternate Modbus TCP port.

• Alternate Modbus TCP port: After selecting Enable alternate modbus TCP port, enter
the alternate TCP port number here. Valid port numbers are from 1 to 65535. The meter
will not allow some port numbers that are either used by the meter or are defined port
numbers for other protocols. MeterLink™ will prompt you if it was not able to write the
specified port number to the meter.

2.8  Set up HART® communications
Rosemount Ultrasonic Flow Meters are HART-capable devices utilizing the 4-20 mA signal
Analog Output 1 on the CPU Module, in which the digital signal is sent from the field device
(Rosemount Ultrasonic Flow Meter) to the host (PC running AMS Device Manager or a Field
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Communicator). An external 24 V power supply is required for the analog signal from the
CPU Module.
The HART Device Description application provides dynamic variables, device-specific
commands, universal commands and common practice commands in accordance with
the HART Communication Foundation. The Device Description defines the communication
details from the device to the host (e.g. menus for the Field Communicator, graphical
displays for AMS Device Manager and the device parameters - process variables,
pressure, temperature, diagnostics and three status alert groups - Failed, Maintenance
and Advisory). Refer to the HART Field Device Specification (00825-0300-3810) for details.
Also, see AMS Device Manager and Field Communicator websites:
• Emerson.com/AMSDeviceManager
• Emerson.com/FieldCommunicators

2.9  Set up the meter in a DeltaV System
Rosemount 3810 Series Ultrasonic Flow Meters are compatible with DeltaV System
communications. The following are optional communications configurations of Rosemount
Ultrasonic Flow Meters:
• Serial connection for RS-232 or RS-485
• Ethernet
• HART®

• Modbus TCP/IP (requires a VIM card)
Refer to the Install Your Digital Automation System Manual for field wiring terminations,
I/O interface, power, and DeltaV control Network.
• Access the DeltaV website hyperlink:

Emerson.com/DeltaV
• Click Books Online under Quick Links.
• Set up your user account and access the manual.

2.10  Manage users
Starting with Rosemount 3810 Series Firmware v1.60, the meter will authenticate any user
making a connection to the meter using MeterLink™.
MeterLink will prompt for a username and password that will be authenticated by the
meter before a successful connection is established.
Only users with an Administrator user type can access the Meter → Manage Users dialog
box in MeterLink to add, change, or delete users within the user database. Changes to
the user database are not write protected by the WRITE PROT. switch. A user with the
Administrator user type can also export and import the user database from one meter
to another to facilitate the user management function across multiple meters. MeterLink
v1.90 or later is required to make a connection to a meter requiring user authentication.
Note
Modbus® protocols do not support authentication so meters cannot authenticate
communications over these protocols. No changes have been made to how these protocols
function.
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2.10.1  User set up
Open MeterLink™ and connect to the meter as user with the Administrator user type.
Access Meter → Manage Users, to bring up the dialog box to add, change or delete users.
A maximum of 25 users can be set up in a meter. The following are the rules needed to
successfully set up new users in a meter:
To set up new users in a meter:
Username
Usernames can be from 1 to 20 characters in length. Usernames are stored in the meter in
all lowercase lettering. The user can enter a username in upper or lowercase lettering, but
it will be converted to lowercase for authentication.
The following characters are allowed:
• Uppercase letters (A to Z)
• Lowercase letters (a to z)
• Numbers (0 to 9)
User type
There are three user types supported:
User type Description
Administrator Full read/write capability plus privileges for user management
Engineer Full read/write capability but without user management privileges
Operator Read-only capability. Operator is not allowed to acknowledge alarms.

At least one user with the Administrator user type must be always configured in the meter.
The meter will not allow the last user with an Administrator user type to be deleted.
Multiple users can have the same user type.
Passwords
Passwords must be 8 to 20 characters long. Only characters from the following groups are
allowed:
• Must have at least one uppercase letter (A-Z)
• Must have at least one lowercase letter (a-z)
• Must have at least one number (0-9)
• Must have at least one special character from the following:

— & (Ampersand)
— * (Asterisk)
— @ (At symbol)
— \ (Backslash)
— ^ (Caret-circumflex)
— ) (Close parenthesis)
— } (Closing brace)
— ] (Closing bracket)
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— : (Colon)
— , (Comma)
— $ (Dollar)
— = (Equals)
— ! (Exclamation mark)
— ` (Grave accent)
— > (Greater than)
— - (Hyphen)
— < (Less than)
— # (Number)
— { (Opening brace)
— [ (Opening bracket)
— ( (Open parenthesis)
— % (Percentage)
— . (Period)
— + (Plus)
— ? (Question mark)
— ; (Semicolon)
— / (Slash)
— " (Straight double quote)
— ' (Straight single quote or Apostrophe)
— ∼ (Tilde)
— _ (Underscore)
— | (Vertical bar)

2.10.2  Import/export user database
To help facilitate managing users across multiple meters, there are options to export and
import the user database from one meter to another.
This allows user to be set up on one meter and easily transferred to others. These
functions are also needed in the event a central processing unit (CPU) module in a meter
must be cold started to default values or replaced.
To export the user database from the meter to a local file on your computer, click Export
under Meter → Manage Users in MeterLink™. MeterLink will prompt for a password for the
meter to use to encrypt the database to provide some level of security for this file once
MeterLink saves it to your computer. This encrypted user database file and the password
must be kept in a secure location since it contains sensitive information such as usernames
and passwords.
To import an encrypted user database file on your computer to a meter, click Import under
Meter → Manage Users in MeterLink. MeterLink will prompt for the password that was
used to encrypt the file during export. The file and password will be sent to the meter and
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if the meter can successfully decrypt the file, the existing user database in the meter will be
deleted and replaced with the imported user database.

2.10.3  Reset users
It is important to keep track of the login credentials for at least one use with the
Administrator user type to avoid a situation where administration rights are lost to a
meter.
If this occurs, there is a user reset mode that can be initiated to delete all users in the user
database and restore the default administrator username and password.
Prerequisites
• The default password is Administrator-XXXXX where XXXXX is the non-zero padded CPU

serial number which can be found on a label on the CPU module.
• This operation cannot be done remotely and requires physical access to the CPU

module.
To delete all users and restore back the default administrative user:
Procedure

1. Connect your computer with MeterLink™ to the meter that requires the user
database to be reset using the appropriate cable.

2. To put the meter in reset mode, transition the Port A Override switch on the CPU
module from the Off position to the On position three times within five seconds and
leave the switch in the On position after the third transition.
The meter will enter meter reset mode after 5 seconds, and remain in meter reset
mode for up to two minutes or until a reset action is complete or the Port A override
switch is moved to the OFF position.
Tip
Use a retractable ballpoint pen with the ballpoint retracted as a tool to transition the
switch.

3. Within the two minutes, connect to the meter with MeterLink. A Meter Reset Mode is
enabled dialog box will appear.

4. Click the option to Reset Users.
MeterLink prompts you to confirm that the user database should be reset.
Once the operation is confirmed, the meter will delete the user database and create
the default administrator user. MeterLink will disconnect from the meter.

5. Connect to the meter again using the default administrator username and go to
Meter → Manage Users to setup new users and change the default password for the
administrator user.
Note
For added security, the default username for the administrator user can be
changed.
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3  Flow measurement
3.1  Flow measurement principles

Rosemount 3810 Liquid Ultrasonic Flow Meters measure the transit times of ultrasonic
pulses passing through the medium on two parallel planes. The measurement paths,
referred to as “chords”, are angled to the pipe axis, and each chord has two transducers
acting alternately as transmitter and receiver.
Figure 3-1 describes the flow measurement principle. This permits the transit times to be
measured both with and against the flow (upstream and downstream).
The transducers are mounted on the meter body at accurately known locations for each
pipe size so the distance L between opposing transducers and the angle are precisely
defined for the measurement path.

Figure 3-1: Transit-time measurement principle

Figure 3-2: 3812 measurement principle
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3.1.1  Transducer timing control
Transducer timing control, the performance of batch data collection and calculation
updates in Rosemount 3810 Liquid Ultrasonic Flow Meters is affected by the following
parameters:
• Signal processing
• Batch cycle processing

Figure 3-3: Signal Analyzer - update rate, stack size, filter and emission rate

3.1.2  Terminology for flow measurement
• Sequence - A complete cycle of firing all enabled transducers in a single round of

transducer operation. For example, when all eight transducers of the Rosemount 3814
Liquid Ultrasonic Flow Meter have been fired in a single round of operation, it signifies
the completion of one sequence.

• Stacking - The process of modifying a sequence so that each individual transducer
is fired “x” times (where x equals the stack size) before the next transducer in the
sequence is fired.

• Stack size - The multiple number of times each transducer is fired before the next
transducer within the sequence is fired.
When stacking is absent or disabled, the stack size is actually 1, because each enabled
transducer is fired once during the sequence. When stacking is applied or enabled, it
is applied increments of 2, 4, 8, and 16 and are the only stack size choices, so that
each enabled transducer is fired 2, 4, 8, or 16 times before the next transducer in the
sequence is fired.

• Emission rate - The time elapsed before the next transducer in a sequence is fired,
regardless of stack size (minimum emission rate is 2 milliseconds with the Filter ON or
OFF). Emerson recommends the default Filter setting, which is the OFF position.

• Stack emission rate - The time elapsed before a single transducer is re-fired when
stacking is enabled. Minimum stack emission rate is 2 milliseconds with the Filter OFF.

• Chords inactive or active - The exclusion or inclusion of a chord-forming pair of
transducers in the sequence of transducer operation.

• Update time - The time elapsed, in seconds, between each processing, or recalculation
of data that is collected from sequences of transducer firings.
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• Batch period, or batch cycle - Synonymous with Update time.
• Sample - Refers to one point on the waveform as in samples per cycle. The data that

is collected from one Sequence of transducer operation. This term is displayed in the
MeterLink™ Signal Analyzer screen, and is nearly synonymous with Sequence, as defined
above. That is, Samples/update, as displayed in the MeterLink Signal Analyzer Wizard,
could be interpreted as Sequences/update. This shows the average number of new
samples collected during an update period.

3.1.3  Signal processing
Signal processing for transit time measurement
The signal at the receiving transducer is amplified, digitized and processed digitally to
provide accurate transit time measurement.
A measure of the signal “quality” is the Signal-to-Noise Ratio (SNR). The higher the SNR,
the better the signal. In general, there are two types of noise: “white” noise and “colored”
noise. White noise is noise that occurs across the frequency spectrum and is asynchronous
to the transmitted signal. Colored noise is concentrated around a particular frequency
and can be synchronous with the transmitted signal. The meter provides two methods for
improving the received signal waveform SNR by reducing the noise energy: Stacking and
Filtering.

3.1.4  Stacking
Transducer firing method
Stacking is a method of firing a transducer multiple times and averaging the received
signals on a point-by-point basis.
Stacking is effective on asynchronous noise such as is typically seen with valve noise. This
method is not useful for removing synchronous noise and should not be used when there
is a great deal of signal “jitter”. Meters are configured by default with a stack size of 2.
Care should be taken when turning off stacking and it is recommended to consult with
Emerson Customer Support if you are unsure of how stacking a signal can affect the
meter's operation. Refer to Technical Support under the Help menu of MeterLink™ for
contact information.
The number of consecutive times to fire each transducer is specified via the StackSize
data point. Available stack sizes are 1 (None), 2, 4, 8, and 16. A stack size of 1 selects no
stacking (i.e., stacking disabled). Stacking is only available when the standard update rate is
selected.

3.1.5  Filtering
Frequency bandpass filter
Filtering applies a bandpass filter that removes noise that is above and below the
transducer frequency. Filtering is effective on noise outside of the frequency passband
of the filter (e.g., filtering works on any noise outside of the passband of the filter). Filtering
is enabled and disabled via the Filter data point (TRUE = enable filtering, FALSE = disable
filtering).
Meters are configured by default with filtering disabled.
Note
Emerson recommends the default Filter setting, which is the OFF position.
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Care should be taken when enabling and disabling filtering and it is recommended to
consult with Emerson Customer Support if you are unsure of how this change can affect
the meter's operation. Refer to Technical Support under the Help menu of MeterLink™ for
contact information.

3.1.6  Batch cycle processing
Batch update period
Calculation updates performed by the meter, for deriving volume and velocity, are
based on batches of data samples collected from sequences of transducer firings.
The batch update period is dependent upon the user specified batch update period
(SpecBatchUpdtPeriod) and the stack size (StackSize) as shown in Table 3-1. The Standard
batch update period is the default. The actual batch update period is readable via the
BatchUpdatePeriod data point.
Table 3-1: Actual meter update period
SpecBatchUpddtPeriod Stacksize

1 (None) 2 4 8 16
Rapid (250 ms) 0.25 sec N/A N/A N/A N/A
Standard (1000 ms) 1 sec 1 sec 1.5 sec 3 sec 5 sec

3.2  Smoothing
Smoothing output
The Rosemount Liquid Ultrasonic Flow Meter introduces a method for smoothing the
output (particularly the frequency output) by averaging times collected from past batch
periods with new times for the current batch period.
Smoothing can be applied in the following increments: 0 (i.e., smoothing is disabled), 20,
40, 60, or 80%.
For example, setting Smoothing to 20% means that of the samples used for the current
update, 20% will be from previously collected samples and 80% will be from the newly
collected samples. Thus, if eight new samples are collected, then those eight samples along
with the last two previous samples would be used together for the current update period
calculations.
Meters are configured by default for Smoothing of 0% (only new samples are used for the
current update period).

3.3  Acquisition mode
Signal acquisition
The Rosemount 3810 Series Liquid Ultrasonic Flow Meter has two modes of normal
operation: Acquisition and Measurement. The Acquisition mode is used to acquire the
ultrasonic signals. This mode is entered upon powering up the meter. Once the ultrasonic
signals are acquired, the Measurement mode is entered and the flow velocity is measured.
The meter remains in the Measurement mode as long as at least one chord is operational.
If while in the Measurement mode all chords fail, then the meter re-enters the Acquisition
mode. If the VelHold data point is set to a value greater than zero, then, while in the
Acquisition VelHold mode, the meter holds the average weighted flow velocity to the last
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good value for up to the VelHold number of batches before setting the velocity to zero. The
VelHold default value is 0.
The meter operation mode is indicated by the IsAcqMode data point. When TRUE, the
meter is in the Acquisition mode; when FALSE, the meter is in the Measurement mode.
The Acquisition mode uses the chords' “L” dimensions (LA…LD as appropriate to the meter
type) and the specified minimum and maximum sound velocities (SSMin and SSMax) to
determine the signal search range.

3.3.1  Re-acquisition mode
Re-acquire transducer signals
When fewer than MinChord (default 1) chords are good, then the meter re-enters the
Acquisition mode. If MinChord is set to the number of active chords, the meter will
reacquire on the first time a chord is failed for a batch.
Note that failed for a batch is different from hard failed. A chord fails for a batch when
PctGood[A1..D2] is less than MinPctGood.
Hard fails occur after AlarmDef number of batches in a row.
If the VelHold data point is set to a value greater than zero, then, while in the Acquisition
mode, the meter holds the average weighted flow velocity to the last good value for up
to the VelHold number of batches before setting the velocity to zero. The VelHold default
value is 0.0.

3.4  Chord average flow and sound velocity
measurements
At each batch update period, each firing path's transit time measurements are averaged.
The average (mean) value for each path is available via data points MeanTmA1 ... MeanTmD2
(as appropriate for the meter type).
Note
The data point names often use a “short-hand” way of identifying the receiving transducer.
The last two characters identify the chord (A...D) and the transducer (1=upstream,
2=downstream). For example, MeanTmA1 is the mean transit time for the chord A
upstream transducer.
The difference between a chord's average upstream transit time and average downstream
transit time is the average delta time. The chord's average times and the chord “X” and
“L” dimensions are used to calculate the flow velocity and sound velocity measured by the
chord as shown in Equation 3-1 and Equation 3-2.

Equation 3-1: Chord Average FlowVchord =  Lchord22Xchord t1 ‐ t2t1 t2
Equation 3-2: Chord Speed of SoundCchord,classic = Lchord2 t1+ t2t1 t2
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3.4.1  Average Flow Velocity
The average velocity is calculated as the average sound velocity of the active chords as
shown in the equation below:

Equation 3-3: Average Flow Velocity

CAvg = ActiveCℎords • CCℎordNumActiveCℎords
CAvg = Average sound velocity (m/s)
CChord = Chord average sound velocity (m/s) (SndVelA...SndVelD)
NumActiveChords = Number of active chords

3.4.2  Average flow velocity using chord proportions
In the event of one or more chord failure(s), the meter operation is dependent upon the
number of non-failed chords.
• If there is at least one operating chord, then the meter uses a velocity estimation

method described in the following paragraphs.
• If all chords fail, then the meter re-enters the Acquisition mode as described in the

“Re-acquisition”section below.
The meter partitions the velocity range (for forward and reverse flow) into ten consecutive,
non-overlapping “bins” (where the velocity range is as specified via the MeterMaxVel data
point). The meter maintains a set of bins for each active chord where each bin contain
three data values:

1. The chord’s average velocity (within the bin’s velocity range)
2. The chord’s average proportion value
3. An indicator that the value is still the default (Is[Fwd/Rev]Prop[A..D]DfltBin[1..10])

A chord proportion value is the ratio of the chord velocity to the average weighted flow
velocity as shown in Equation 3-4. The default indicator is used to determine if a bin’s
velocity and proportion data values have been updated from their initialized values. The
bins are initialized with the average velocity over the bin’s range and meter-geometry-
dependent proportion values. All default indicators are initialized to TRUE. The bin data is
stored in non-volatile memory.

Equation 3-4: Chord Proportion CalculationPropcℎord = VcℎordVAvgWtd
Propchord = chord proportion (dimensionless)
Vchord = chord velocity (m/s) (FlowVelA ... FlowVelD)
VAvgWtd = average weighted liquid flow velocity (m/s) (AvgWtdFlowVel)

3.4.3  Update chord proportion bin data values
When the meter has operated for a user-specified number of consecutive batches without
any chord failures, the meter updates each chord’s data values for the bin containing the

Flow measurement Operations Manual
March 2025  00809-0200-3810

24 www.Emerson.com

https://www.emerson.com/global


chord velocity as shown in Equation 3-5 and sets the bin’s default indicator to FALSE. The
PropUpdtBatches data point, configurable via the MeterLink™ Edit/Compare Configuration
screen, specifies the number of consecutive failure-free batches required for updating the
bin data (range: [1, 1000], default: 24). The NumVals data point (that determines how
quickly an average value changes) is also configurable via the Edit/Compare Configuration
screen (range: [1, 1000], default: 10).

Equation 3-5: Updating chord proportion bin data valuesAvgVelCℎordBinn+ 1 = AvgVelCℎordBinn NumVals − 1 + VCℎordNumValsAvgPropCℎordBinn+ 1 = AvgPropCℎordBinn NumVals − 1 + PropCℎordNumVals
AvgVelChordBinn+1 = chord bin (n+1)th average velocity (m/s)
AvgVelChordBinn = chord bin nth average velocity (m/s)
NumVals = update factor data point (dimensionless) (NumVals)
VChord = (current-batch) chord average flow velocity (m/s) (FlowVelA ...

FlowVelD)
AvgPropChordBinn+1 = chord bin (n+1)th average proportion value (dimensionless)
AvgPropChordBinn = chord bin nth average proportion value (dimensionless)
PropChord = (current-batch) chord proportion (dimensionless)

3.5  Volumetric flow rate values
The Rosemount Liquid Ultrasonic Flow Meter provides two volumetric flow rate values: raw
and flow-condition.
The flow-condition volumetric flow rate can include pressure and/or temperature-
expansion correction for meter body expansion.
Note
A positive volumetric flow rate indicates flow in the forward direction whereas a negative
volumetric flow rate indicates flow in the reverse direction.

3.5.1  Raw volumetric flow rates
Equation 3-6: Raw Volumetric Flow RateQRaw = VCustomerCal × πDm24 × 3600s/ℎr
QRaw= “raw” volumetric flow rate (m3/h) (QMeter)
VCustomerCal= customer-calibrated average flow velocity (m/s) (AvgFlow)
π = geometric constant, pi (dimensionless) (3.14159...)
Din= pipe inside diameter (m) (PipeDiam)
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3.5.2  Flow-condition volumetric flow rate
The flow-condition volumetric flow rate is the result of applying expansion correction to the
raw volumetric flow rate as shown in the following equation, subject to the low-flow cut-off.
If the resulting value is below the low-flow cut-off value, it is set to zero. The low-flow
cut-off volumetric flow rate (CutRate) is the specified low-flow velocity threshold (ZeroCut)
converted to a volumetric flow rate.

Equation 3-7: Flow condition volumetric flow rateQFlow = (QRaw)(ExpCorrP)(ExpCorT)
QFlow= flow-condition volumetric flow rate (m3/h) (QFlow)
QRaw = “raw” volumetric flow rate (m3/h) (QMeter)
ExpCorrP = expansion correction factor due to pressure (dimensionless)

(ExpCorrPressure)
ExpCorrT = expansion correction factor due to temperature (dimensionless)

(ExpCorrTemperature)

3.5.3  Pressure Expansion Correction
The meter is capable of correcting the raw volumetric flow rate for the effect of pipe
expansion due to pressure changes. Note that for the pressure-effect expansion correction
factor to be calculated, the correction must be enabled (via the EnableExpCorrPress data
point) and the flow-condition pressure must be available (i.e., the EnablePressureInput
data point must be set to “Live”(1) or “Fixed”(2).

Equation 3-8: Pressure Expansion CorrectionExpCorrP = 1 + 3 × β × Pabs, ƒ − Pref
ExpCorrP= expansion correction factor due to pressure (dimensionless) (ExpCorrPressure)
ß = pipe strain per unit stress (MPaa-1) (StrainPerUnitStress)
Pabs,f= flow-condition absolute pressure (MPaa) (AbsFlowPressure)
Pref= reference absolute pressure (MPaa) (0.101325 MPaa)

Equation 3-9: Pressure-effect strain per unit stress

β = Dout2 1 + υ + Din2 1− 2υΕ • Dout2 − Din2
ß = pipe strain per unit stress (MPaa-1) (StrainPerUnitStress)
Dout = outside diameter of the meter or pipe (m) (PipeOutsideDiameter)
Din = inside diameter of the meter or pipe (m) (PipeDiam)
υ = Poisson’s Ratio (dimensionless) (PoissonsRatio)
E = Young’s Modulus of elasticity (MPaa) (YoungsModulus)
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3.5.4  Temperature expansion correction
The meter is capable of correcting the raw volumetric flow rate for the effect of
pipe expansion due to temperature changes. Note that for the temperature-effect
expansion correction factor to be calculated, the correction must be enabled (via the
EnableExpCorrTemp data point) and the flow-condition temperature must be available
(i.e., the EnableTemperatureInput data point must be set to “Live”(1) or “Fixed”(2). See the
Equation 3-10.

Equation 3-10: Temperature Expansion CorrectionExpCorrT = 1 + 3 × α × Tƒ − Tref
ExpCorrT = expansion correction factor due to temperature (dimensionless)

(ExpCorrTemperature)
α = pipe linear expansion coefficient due to temperature (K-1)

(LinearExpansionCoef)
Tf = flow-condition temperature (K) (FlowTemperature)
Tref = reference temperature for the pipe linear expansion coefficient (K)

(RefTempLinearExpCoef)

3.5.5  Reynolds number calculation
Reynolds Number is a dimensionless value that represents the nature of the liquid flow
within the pipe. Reynolds Number is calculated as shown in Equation 3-11.

Equation 3-11: Reynolds Number Re = 4π QRawρ ρfTf3600*Dinμ
Re= Reynolds Number (dimensionless) (ReynoldsNumber)
π = geometric constant, pi (dimensionless) (3.14159...)
QRaw = “raw” volumetric flow rate (m3/h) (QMeter)
P(PƒTƒ) = fluid mass density at the flow condition (specified via SpecRhoMixFlow) (kg/m3)

(RhoMixFlow)
Din = pipe inside diameter (m) (PipeDiam)
µ = dynamic viscosity (Pa•s) (Viscosity)

3.5.6  Volume forward and reverse accumulators
Flow rate forward and reverse volume accumulators
The Rosemount 3810 Series Liquid Ultrasonic Flow Meter provides forward and reverse
volume accumulators for both of the two volumetric flow rate values: raw and flow-
condition. Each volume accumulator is actually stored as a data pair: 64-bit unsigned
integer portion, 32-bit floating point fractional portion.
For example, a volume of 12345.750 m3 is stored as 12345 m3 for the integer portion and
0.750 m3 as the fractional portion. Note that while a volumetric flow rate can be positive
(indicating forward flow) or negative (indicating reverse flow), the volume accumulators are
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always positive values. The non-volatile volume accumulator data points are listed in Table
3-2 below:
Table 3-2: Non-volatile volume accumulator data points
Volumetric Flow
Rate Type

Forward flow direction Reverse flow direction

Integer Fraction Integer Fraction
Raw PosVolUncorr PosVolUncorrFrac NegVolUncorr NegVolUncorrFrac
Flow-condition PosVolFlow PosVolFlowFrac NegVolFlow NegVolFlowFrac

3.6  3810 Series liquid flow meter diagnostics
Symmetry
Symmetry is a dimensionless measure of the flow symmetry comparing the upper chords
to the lower chords and is readable via the Symmetry data point. Ideally, the Symmetry
should be 1.0.
Note
This is only applicable to 3814, 4-path meter types.

Cross-flow
Cross-flow is a dimensionless measure of the flow symmetry comparing the chords on one
side of the meter to the chords on the other side. It is readable via the CrossFlow data
point. Ideally, the Cross-flow should be 1.0.
Chord turbulence
Chord Turbulence is a estimate of the turbulence (percentage) at a chord location. A value
is calculated for each active chord and is readable via the TurbulenceA, TurbulenceB,
TurbulenceC, or TurbulenceD data points. A value of 0% indicates no appreciable
turbulence.
Profile factor
The profile factor is a dimensionless ratio of the inner chord velocities to the outer chord
velocities. It is readable via the ProfileFactor data point. Ideally, the Profile Factor should be
1.17 ±0.05 for 3814 meters and 1.0 for 3812 meters.
Swirl angle
The swirl angle is an estimate of the swirl (to the nearest degree) and is readable via the
SwirlAngle data point. It is calculated as a function of the meter body style (3814) and
Profile factor. A value of 0 degrees indicates no appreciable swirl.
Reverse flow detection
Reverse flow direction is detected if the meter has accumulated a reverse flow volume
greater than a user-configurable limit set in the Reverse Flow Volume Limit. See Reverse
flow alarm to configure the volume limit.
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4  Configurations
4.1  Calibration methods

Factory calibration and user-defined calibration
The Rosemount 3810 Series Liquid Ultrasonic Flow Meter uses two calibration corrections:
• Factory Calibration
• Customer Calibration
In this methodology, the “Factory Calibration” values are set by Emerson at the factory and
are not expected to be modified; the “Customer Calibration” values are expected to be set
as the result of a user flow calibration (if desired).

4.1.1  Factory calibration method
Important
The WRITE PROT. switch on the CPU Module must be disabled (OFF) before writing
calibration factors to the meter. After the meter is configured, enable the WRITE
PROT. switch (ON) to write-protect the configuration. Collect a Maintenance Log and
configuration file for the meter’s “As left” configuration settings.

 CAUTION
Modification of the factory calibration parameters is not recommended. The dry calibration
parameters should not be modified unless directed by Emerson representative.

The factory calibrated flow velocity is the result of applying a third-order polynomial
equation to the average weighted flow velocity as shown in Equation 4-1.

Equation 4-1: Factory-Calibrated Average Flow VelocityVFactoryCal = A0+ A1VAvgWtd+ A2VAvgWtd2 + A3VAvgWtd3
VFactoryCal = factory-calibrated average flow velocity (m/s) (FactoryCalVel)
VAvgWtd = average weighted flow velocity (m/s) (AvgWtdFlowVel)
A0 = factory-calibration 0th order coefficient (m/s) (FwdA0 or RevA0)
A1 = factory-calibration 1st order coefficient (dimensionless) (FwdA1 or RevA1)
A2 = factory-calibration 2nd order coefficient (s/m) (FwdA2 or RevA2)
A3 = factory-calibration 3rd order coefficient (s2/m2) (FwdA3 or RevA3)

Note
The meter provides a set of factory calibration coefficients for each flow direction.
The meter provides separate factory calibration coefficients for each flow direction as listed
in the table below:
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Table 4-1: Factory calibration coefficients
MeterLink™ Display Name Data Points, Options and Guidelines
Forward A0 Data points affected:

• FwdA0
Options:
• Enter a value (m/s or ft/s) within the range [‑1,1 m/s].
Guidelines:
• This value must only be modified under direction of

Emerson representative.

Forward A1 Data points affected:
• FwdA1
Options:
• Enter a value (dimensionless) within the range

[0.95,1.05].
Guidelines:
• This value should only be modified under direction of

Emerson representative.

Forward A2 Data points affected:
• FwdA2
Options:
• Enter a value (s/m or s/ft) within the range [‑0.1,0.1

s/m].
Guidelines:
• This value should only be modified under direction of

Emerson representative.

Forward A3 Data points affected:
• FwdA3
Options:
• Enter a value (s2/m2 or s2/ft2) within the range

[‑0.1,0.1 s2/m2].
Guidelines:
• This value should only be modified under direction of

Emerson representative.

Reverse A0 Data points affected:
• RevA0
Options:
• Enter a value (m/s or ft/s) within the range [‑1,1 m/s].
Guidelines:
• This value should only be modified under direction of

Emerson representative.
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Table 4-1: Factory calibration coefficients (continued)
MeterLink™ Display Name Data Points, Options and Guidelines
Reverse A1 Data points affected:

• RevA1
Options:
• Enter a value (dimensionless) within the range

[0.95,1.05].
Guidelines:
• This value should only be modified under direction of

Emerson representative.

Reverse A2 Data points affected:
• RevA2
Options:
• Enter a value (s/m or s/ft) within the range [‑0.1,0.1

s/m].
Guidelines:
• This value should only be modified under direction of

Emerson representative.

Reverse A3 Data points affected:
• RevA3
Options:
• Enter a value (s2/m2 or s2/ft2) within the range

[‑0.1,0.1 s2/m2].
Guidelines:
• This value should only be modified under direction of

Emerson representative.

4.1.2  Customer calibration method
The Rosemount 3810 Series Liquid Ultrasonic Flow Meter offers forward and reverse meter
factors for Customer Calibration. The Customer Calibration method to use is selected via
the CalMethod data point with None (0) being the default value (i.e., do not apply any
meter factor).

Equation 4-2: Customer-Calibrated Average Flow VelocityVCustomerCal = VFactoryCal
VCustomerCal = Customer-calibrated average flow velocity (m/s) (AvgFlow)
VFactoryCal = Factory-calibrated average flow velocity (m/s) (FactoryCalVel)

In order for the appropriate meter factor to be applied, the CalMethod data point must be
set to “Meter Factor” (3). In that case, the meter shall apply the appropriate meter factor as
shown in the following equation:
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Equation 4-3: Customer-Calibrated Average Flow VelocityVCustomerCal = VFactoryCal ×MtrFctr
VCustomerCal = Customer-calibrated average flow velocity (m/s) (AvgFlow)
VFactoryCal = Factory-calibrated average flow velocity (m/s) (FactoryCalVel)
MtrFctr = Meter factor (dimensionless) where MtrFctr = FwdMtrFctr if FactoryCalVel ≥

0, RevMtrFctr otherwise

Select the desired Customer Calibration by configuring the data point listed in the Table
4-2 ; from the MeterLink™ Calibration - Meter Factors page.
Table 4-2: Customer Calibration
MeterLink Display Name Data Points, Options and Guidelines
Flow calibration method Data points affected: CalMethod

Options:
• None (0)
• Meter Factor (3)
• High Viscosity Method (Disabled - default)

(Enabled)
Guidelines: This value should only be modified
under direction of Emerson Representative.

Note
Should your high viscosity meter need to be re-calibrated, contact Emerson Customer
Support.

4.1.3  High viscosity calibration method
If High Viscosity Method is set to “Enabled”, then the linear flow velocity is a
result of applying the zero calibration high viscosity flow offset (FwdA0HighViscosity
or RevA0HighViscosity) and the high viscosity piecewise linearization meter factor
(LinearMtrFctrHighViscosity) to the average weighted flow velocity (AvgWtdFlowVel).
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Figure 4-1: Configure High Viscosity Method

High viscosity meter factors
Table 4-3: Piecewise linearization forward high viscosity meter factors
PWL High forward viscosity meter factors 3810 Series datapoint
Piecewise linearization forward high viscosity meter factor 1 FwdMtrFctrHighViscosity1
Piecewise linearization forward high viscosity meter factor 2 FwdMtrFctrHighViscosity2
Piecewise linearization forward high viscosity meter factor 3 FwdMtrFctrHighViscosity3
Piecewise linearization forward high viscosity meter factor 4 FwdMtrFctrHighViscosity4
Piecewise linearization forward high viscosity meter factor 5 FwdMtrFctrHighViscosity5
Piecewise linearization forward high viscosity meter factor 6 FwdMtrFctrHighViscosity6
Piecewise linearization forward high viscosity meter factor 7 FwdMtrFctrHighViscosity7
Piecewise linearization forward high viscosity meter factor 8 FwdMtrFctrHighViscosity8
Piecewise linearization forward high viscosity meter factor 9 FwdMtrFctrHighViscosity9
Piecewise linearization forward high viscosity meter factor 10 FwdMtrFctrHighViscosity10
Piecewise linearization forward high viscosity meter factor 11 FwdMtrFctrHighViscosity11
Piecewise linearization forward high viscosity meter factor 12 FwdMtrFctrHighViscosity12

Table 4-4: Piecewise linearization reverse high viscosity meter factors
PWL reverse High viscosity meter factors 3810 Series datapoint
Piecewise linearization reverse high viscosity meter factor 1 RevMtrFctrHighViscosity1
Piecewise linearization reverse high viscosity meter factor 2 RevMtrFctrHighViscosity2
Piecewise linearization reverse high viscosity meter factor 3 RevMtrFctrHighViscosity3
Piecewise linearization reverse high viscosity meter factor 4 RevMtrFctrHighViscosity4
Piecewise linearization reverse high viscosity meter factor 5 RevMtrFctrHighViscosity5
Piecewise linearization reverse high viscosity meter factor 6 RevMtrFctrHighViscosity6
Piecewise linearization reverse high viscosity meter factor 7 RevMtrFctrHighViscosity7
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Table 4-4: Piecewise linearization reverse high viscosity meter factors (continued)
PWL reverse High viscosity meter factors 3810 Series datapoint
Piecewise linearization reverse high viscosity meter factor 8 RevMtrFctrHighViscosity8
Piecewise linearization reverse high viscosity meter factor 9 RevMtrFctrHighViscosity9
Piecewise linearization reverse high viscosity meter factor 10 RevMtrFctrHighViscosity10
Piecewise linearization reverse high viscosity meter factor 11 RevMtrFctrHighViscosity11
Piecewise linearization reverse high viscosity meter factor 12 RevMtrFctrHighViscosity12

Table 4-5: Zero calibration high viscosity offset parameters
Zero calibration parameter 3810 Series datapoint
Zero calibration high viscosity forward flow offset FwdA0HighViscosity
Zero calibration high viscosity reverse flow offset RevA0HighViscosity

4.1.4  Calibrate the meter factors
Calibrate Meter factor parameters

Procedure
1. Use the Calibration → Meter Factors menu and select Flow Calibration Method → 

Meter Factor from the dropdown menu.
2. Enter the appropriate forward and reverse meter factors and click Write to send

the factors to the meter.

3. For High Viscosity applications, use the Calibration → Meter Factors menu and select
Flow Calibration Method → Meter Factor from the dropdown menu.
• Select High Viscosity Method Enabled from the dropdown menu. See High

viscosity calibration method for additional configuration parameters.
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4. Click Close to exit the dialog box. If you made changes, click the Write button to
apply the changes.

5. After the meter is configured, set the WRITE PROT. switch on the CPU Module to the
ON position to write-protect the meter's configuration.

4.1.5  Configure the flow calibration parameters
Procedure

1. Use the Calibration → Flow Calibration menu and select Flow Calibration Type
(timed or gated). A gated calibration records the volume seen between switch
closures directly from a prover for the number of passes it takes for the prover
to make a run.

a) Click Timed calibration for the meter to record the volume through the meter
over a user specified period of time for a calibration run. Use the spin buttons
or type in the number of passes of a prover to make a run.

Figure 4-2: Timed Flow Calibration Setup dialog

b) Click Change to change the folder location where the Calibration Log file is
saved.

2. Click Gated and use the spin buttons or type in the number of passes of a for prover
to make a run. A gated calibration records the volume seen between switch closures
directly from a prover for the number of passes it takes for the prover to make a
run.

3. Select the Calibration input start/stop detection from one of the following options:
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Figure 4-3: Edge gated, active high

Figure 4-4: Edge gated, active low
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Figure 4-5: State gated, active high

Figure 4-6: State gated, active low

4. Click OK to apply the selected parameters.
A Microsoft Excel® file is generated and the calibration log report can be saved or
appended to an existing file.

5. Click Cancel to close the dialog box without making changes. If you made changes,
click the Write to apply the changes.

6. After the flow calibration parameters are configured, set the WRITE PROT. switch on
the CPU Module to the ON position to write-protect the configuration.
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4.1.6  Zero calibration
Calibration menu
The Zero Calibration dialog allows you to zero a Rosemount Liquid Ultrasonic meter that is
in a no flow condition.
When the dialog is displayed, MeterLink™ will start reading and charting the flow velocity
measured by the meter. The status LEDs will also be updated to report any warnings or
alarms.

Zero flow calibration
Prerequisites
Before Performing a Calibration:
• If this is a first time start up of a meter, run enough flow through the meter to remove

any trapped air from the meter and from the face of the transducers before blocking in
the meter.

• Ensure the entire volume of the meter is full of the process fluid.
• Allow enough time after blocking in the meter before starting the calibration to ensure

there is no flow through the meter.
• The meter velocity reported by MeterLink™ should be stable and very close to zero flow.
Calibration options
Before starting the zero calibration, you can adjust Zero time which is the length of time
the MeterLink collects data from the meter for the calibration. Lowering this value can
increase the chance of passing the calibration but may produce a lower quality calibration.
Increasing this value may decrease the chance of passing the calibration but may improve
the quality of the calibration. Four minutes is the recommended amount of time to
perform a zero calibration. The time can be adjusted from 2 minutes to 10 minutes.
Select Generate report after writing zero calibration to meter if you want an Excel® report
of the “As Found” and “As Left” calibration parameters. The meter's extended configuration
data points are included in the report. All the data collected during the calibration will
also be saved to the meter. This option is only available if Microsoft® Excel® is installed on
the computer running MeterLink. If you do not select this option or it is not available, the
calibration parameter changes are still recorded in the meter's Archive Audit log.
The extended configuration includes some read-only data points that help describe the
meter's configuration. Read-only data points are displayed with a gray background for
reference only and cannot be changed. The extended configuration data points are
viewable in the Maintenance Logs Report, Archive Logs Report, Flow Calibration, Zero
Calibration dialogs and the Edit/Compare Configuration tool.
Performing a calibration

Procedure
1. Use the Calibration → Zero Calibration menu.
2. Start the calibration by clicking Start Zero. The calibration will start and run for the

period of time set in Zero time.
The average flow velocity is the value used to adjust the FwdA0 and RevA0
coefficients in the meter so they remove the offset flow under no flow conditions.

3. The Estimated maximum deviation is also calculated to help verify the meter is in no
flow and is used to set pass/fail criteria for the calibration.
An error will be generated if the Estimated maximum deviation is greater than 0.002
ft/sec or 0.0006 m/sec.
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4. Once the calibration completes and no errors were encountered, click Write to
Meter to send the changes to the meter.
If errors were reported after the calibration, the calibration cannot be written to the
meter.

5. If you selected to generate a report, MeterLink displays a dialog asking you if you
want to display the report once created.

6. Click Stop Zero, at any time during a calibration, to abort the calibration.
7. Click Discard once a calibration completes with no errors, to cancel the calibration

and setup the dialog to perform a new calibration.
8. Click Close to close the Zero Calibration dialog.

4.1.7  Triggered Delta Volumes
The "triggered delta volume" feature provides the ability to measure total liquid flow
volume between two successive external event triggers.
To trigger an event, set the DoUpdtTrigDeltaVols data point to TRUE. This causes
the meter to save the current accumulated flow- and base-condition volume values
(forward and reverse). The meter then calculates the difference between these values
and the corresponding values saved from the previous event trigger. Finally, the meter
writes the delta volume values to the appropriate data points (TrigDeltaPosVolFlow and
TrigDeltaNegVolFlow) and sets the DoUpdtTrigDeltaVols data point to FALSE to clear the
trigger and indicate the calculation completion.
The triggered delta volume functionality is retained across power cycles as the
accumulated volume values at the last event trigger are saved in non-volatile memory.
The delta volume data points are stored internally in non-volatile memory as double-
precision floating point numbers. The delta volume data points can be read via Modbus
as either 32-bit floating point values or as integer values (using the [overflow, lower] LONG
register pair in a manner similar to reading the accumulated volumes).
Suggested User Access Logic
The following pseudo-code demonstrates the logic to access the triggered delta volume
functionality:
Initial Set-Up: Ensure Modbus units are set-up as desired: set Modbus register 95
(UnitsSystem) to 0 for U.S. Customary units or to 1 for metric units.
Periodic Loop:
• Wait for external event for synchronizing the start of the meter delta volumes. Send

trigger Modbus message: set Modbus register 1482 (DoUpdtTrigDeltaVols) to 1 (TRUE).
• Read trigger Modbus register 1482 (DoUpdtTrigDeltaVols) in a loop until it is read as 0

(FALSE) indicating that the delta volumes have been updated.
• Read trigger Modbus register 1482 (DoUpdtTrigDeltaVols) in a loop until it is read as 0

(FALSE) indicating that the delta volumes have been updated.
• Read trigger Modbus register 1482 (DoUpdtTrigDeltaVols) in a loop until it is read as 0

(FALSE) indicating that the delta volumes have been updated.
• Read delta volume registers (either the FLOAT registers or the LONG register pairs) in

a single Modbus read. If the delta volume registers are read as LONG register pairs,
calculate each delta volume as follows:
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Equation 4-4: Triggered delta volumeDeltaVolume = Overflow × 1e9 + Lower
where

DeltaVolume = Triggered delta volume (forward or reverse, flow-condition or base-
condition) (m3 or ft3) (TrigDeltaPosVolFlow, TrigDeltaNegVolFlow, TrigDeltaPosVolBase,
TrigDeltaNegVolBase)
Overflow = Triggered delta volume overflow integer value (forward or reverse, flow-
condition or base-condition) (1e9m3 or 1e9ft.3)
Lower = Triggered delta volume lower integer value (forward or reverse, flow-condition
or base-condition) (m3 or ft.3)

Repeat "PERIODIC LOOP".

4.2  Calibrate analog inputs and outputs
NOTICE
The WRITE PROT. switch on the CPU Module must be disabled or the calibration values will
not be updated for a meter.

An analog input can be calibrated regardless of the corresponding input type, pressure
of temperature. However, if the corresponding input type is selected as Live, then the
input being calibrated is considered to be invalid and the in-use value depends upon the
FlowPOrTSrcUponAlarm selection (see above). In this case, the appropriate data point
(FlowPressureWhileCal, FlowTemperatureWhileCal) is set to the in-use value so that it can
be logged in the optional log.
The offset and gain can be reset to the default values (0 and 1, respectively) by clicking the
Reset Defaults button.

NOTICE
Clicking the Reset Defaults button writes the offset and gain immediately - the previous
values cannot be restored.
Click the Edit Scaling button to modify the input scaling.

NOTICE
Changes made to an analog input's offset, gain, and scaling values are written to the log.

From MeterLink™, select Calibrate to make changes using the Analog Inputs Wizard.
Procedure

1. Choose the analog input to calibrate, either temperature or pressure.
2. Click Next. The Current → Calibration screen shows the current offset and gain and

the input scaling (i.e., the pressures or temperatures corresponding to the minimum
(4 mA) input and maximum (20 mA) inputs).

3. Click Next to proceed to the Calibration → Method screen.
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4. Select either the offset or two-point calibration methods.
• The Offset method requires a single calibration point and only affects the input's

calibration offset parameter.
• The two-point calibration requires calibrating at two different points (ideally far

apart in value) and affects the input's calibration offset and gain parameters.
Depending upon the selected calibration method, either one or two screens will
follow when the Next button is clicked.

5. The screen(s) displays the current (live) reading.
6. When the input is stable, click the Hold button to freeze the current reading.
7. Enter the correct value in the Actual edit box. The Finish screen shows the new

calculated offset and gain values.

Figure 4-7: Offset calibration

8. Click Finish to write the values to the meter. If the meter is not configured to use live
values from the analog input for calculation, a prompt will display asking to change
the configuration to use the live input.

9. Enable the WRITE PROT. switch on the CPU Module to write-protect the
configuration.
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Table 4-6: Calibrate analog inputs and outputs
MeterLink™

Display name
Data Points, options and guidelines

Current output
Output setting

Data points affected:
• AO1TestModeOutputPercent
Options:
• Enter the integer percentage of full scale for the analog output

within the range [0, 100 %] where 0% corresponds to the
minimum output (4 mA) and 100% corresponds to the maximum
output (20 mA).

Guidelines
• The specified test value takes effect within one batch period of

clicking the Start button.

Current output
Start (Stop) AO1

Data points affected:
• IsAO1EnableTest
Options:
• Click on the StartAO1 button to enter the test mode (TRUE).

Note
The Start button will become the Stop button after clicking on it.

• Click on the StopAO1 button to exit the test mode (FALSE).
Note
The Stop button will become the Start button after clicking on it.

Guidelines
• The specified test value takes effect within one batch period of

clicking the Start button.

Current output
Output setting

Data points affected:
• AO2TestModeOutputPercent
Options:
• Enter the integer percentage of full scale for the analog output

within the range [0, 100 %] where 0% corresponds to the
minimum output (4 mA) and 100% corresponds to the maximum
output (20 mA).

Guidelines
• The specified test value takes effect within one batch period of

clicking the Start button.
Note
The AO2 is only available with CPU module, part number
1-360-03-010.
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Table 4-6: Calibrate analog inputs and outputs (continued)
MeterLink™

Display name
Data Points, options and guidelines

Data points affected:
• IsAO2EnableTest
Options:
• Click on the StartAO2 button to enter the test mode (TRUE).

Note
The Start button will become the Stop button after clicking on it.

• Click on the StopAO2 button to exit the test mode (FALSE).
Note
The Stop button will become the Start button after clicking on it.

Guidelines
• The specified test value takes effect within one batch period of

clicking the Start button.

The maximum length of time that the analog output can remain in the test mode
is specified via the NonNormalModeTimeout data point. Note that this data point
applies to other tests as well. The NonNormalModeTimeout data point can be
changed using the MeterLink Edit/Compare Configuration screen. It can be set
within the range [1, 30 min] and has a default value of 2 min.

4.3  Configure Frequency/Digital output sources
The meter has three user-configurable outputs that can be configured for either a
Frequency Output or Digital Output (FODO).
• FODO1 (eight possible parameter configurations) [Type 2] [Type 4]
• FODO2 (eight possible parameter configurations) [Type 2] [Type 4]
• FODO3 (eight possible parameter configurations) [Type 2] [Type 4]
• FODO4 (eight possible parameter configurations) [Type 4]
• FODO5 (eight possible parameter configurations) [Type 4]
• FODO6 (eight possible parameter configurations) [Type 4]

— (DI1Mode must be set to Frequency/Digital Output 6 to enable FODO6)
Frequency or Digital Outputs (FODO1, FODO6) source options ∼ Group 1
• FO1A, DO1A, FO1B, DO1B, FO2A, DO2A, FO2B, DO2B
• Frequency output 1A is the A Phase of Frequency output 1 content (Uncorrected volume

flow rate, Profile Factor)
• Frequency output 1B is the B Phase of Frequency output 1
• Frequency output 2A is based on frequency content (Actual - Uncorrected Flow Rate,

Profile Factor)
• Frequency output 2B is based on frequency content and Frequency 2B Phase
• Digital output 1A is based on Digital output1A content (Frequency Output 1 Validity,

Flow Direction)
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• Digital output 1B is based on Digital output1B content (Frequency Output 1 Validity,
Flow Direction)

• Digital output 2A is based on Digital output 2A content (Frequency Output 2 Validity,
Flow Direction)

• Digital output 2B is based on Digital output 2B content (Frequency Output 2 Validity,
Flow Direction)

Frequency or Digital Outputs (FODO2, FODO3, FODO4, FODO5) source options ∼
Group 2
• FO1A, DO1A, FO1B, DO1B, FO2A, DO2A, FO2B, DO2B
• Frequency output 1A is the A Phase of Frequency output 1 content (Uncorrected volume

flow rate, Profile Factor)
• Frequency output 1B is the B Phase of Frequency output 1
• Frequency output 2A is the A Phase of Frequency output 2 content (Uncorrected volume

flow rate, Profile Factor)
• Frequency output 2B is the B Phase of Frequency output 2 content
• Digital output 1A is based on Digital output1A content (Frequency Output 1 Validity,

Flow Direction)
• Digital output 1B is based on Digital output1B content (Frequency Output 1 Validity,

Flow Direction)
• Digital output 2A is based on Digital output 2A content (Frequency Output 2 Validity,

Flow Direction)
• Digital output 2B is based on Digital output 2B content (Frequency Output 2 Validity,

Flow Direction)
Mode options
• Open Collector (requires external excitation supply voltage and pull-up resistor)
• TTL (internally powered by the meter 0-5 Vdc signal)
Channel B Phase options:
• Lag forward, Lead reverse (Phase B lags Phase A while reporting forward flow, leads

Phase A while reporting reverse flow)
• Lead forward, Lag reverse (Phase B leads Phase A while reporting forward flow, lags

Phase A while reporting reverse flow)
Phase A and Phase B output (based on flow direction)
• Reverse flow - Output only reports flow in the reverse direction. For frequency outputs,

Phase B of the output is 90 degrees out of phase with Phase A.
• Forward flow - Output only reports flow in the forward direction. For frequency outputs,

Phase B of the output is 90 degrees out of phase with Phase A.
• Absolute - Output reports flow in both directions. For frequency outputs, Phase B of the

output is 90 degrees out of phase with Phase A.
• Bidirectional - Output reports flow on Phase A only in the forward direction and on

Phase B only in the reverse direction.
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Maximum frequency for the frequency outputs
• 1000 Hz
• 5000 Hz
Frequency/Digital output Source configuration
Frequency/Digital Output 1
Frequency/Digital Output 2
Frequency/Digital Output 3
Frequency/Digital Output 4
Frequency/Digital Output 5
Frequency/Digital Output 6

• Frequency output 1A
• Frequency output 1B
• Digital output 1A
• Digital output 1B
• Frequency output 2A
• Frequency output 2B
• Digital output 2A
• Digital output 2B

Output for FODO1 and Digital Input 1 (Group 1 on the CPU Module) share a common
ground and have 50 V isolation. FODO2 and FODO3 (Group 2 on the CPU Module) share
a common ground and have 50 V isolation. This allows an output to be connected to a
different flow computer. The outputs are opto-isolated from the CPU Module and have a
withstand voltage of at least 500 V rms dielectric.

Figure 4-8: CPU Module - Frequency/Digital outputs common ground - Type 2

A. FODO1 and Digital Input1 - Shared common ground (Group 1)
B. FODO2 and FODO3 - Shared common ground (Group 2)

Operations Manual Configurations
00809-0200-3810 March 2025

www.Emerson.com 45

https://www.emerson.com/global


Figure 4-9: CPU Module - Frequency/Digital outputs common ground - Type 4

A. FODO1 and DI1/FODO6 - Shared common ground - Type 4 CPU Module (Group 1)
B. FODO2, FODO3, FODO4 and FODO5 - Shared common ground - Type 4 CPU Module

(Group 2)

4.4  Configure digital inputs/outputs
Digital input
The Rosemount 3810 Liquid Ultrasonic Flow Meters provides one digital input (referred to
as DI1). The polarity of the input is configured via the DI1IsInvPolarity data point as follows:
• FALSE - normal polarity (default setting), or
• TRUE - inverted polarity
The digital input is not configurable via the MeterLink™ Field Setup Wizard. It must be
configured via the MeterLink Tools → Edit/Compare Configuration.
Digital input calibration
The IsDI1UsedForCal specifies whether digital input 1 (DI1) is used for general purpose
(when set to FALSE) or for synchronizing calibration (when set to TRUE). If used for
calibration, the polarity is determined by the IsDI1ForCalActiveLow data point select one of
the following:
• FALSE - general purpose (default setting), or
• TRUE - for synchronizing calibration
The IsDI1ForCalActiveLow data point specifies the polarity for digital input 1 (DI1) when
it is configured (via IsDI1UsedForCal) for use in synchronizing a calibration. See also
IsDI1ForCalStateGated.
• FALSE = Cal Active High
• TRUE = Cal Active Low (default)
The IsDI1ForCalStateGated data point specifies the calibration gating for digital input 1
(DI1) when it is configured (via IsDI1UsedForCal) for use in synchronizing a calibration.
When FALSE, the calibration is started/stopped via an inactive → active edge; when TRUE,
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the calibration is started via an inactive → active state change and stopped via an active → 
inactive state change. The active edge/state is specified via the IsDI1ForCalActiveLow data
point.
• FALSE = Cal Edge Gated (default)
• TRUE = Cal State Gated

Digital output
Select the configuration function for the digital output. Available options are validity and
direction.
The inverted operation option is useful if the output of the ultrasonic meter is reversed
from what a flow computer is expecting. This means that if the output normally outputs a
HIGH for a TRUE condition, selecting this checkbox will change the output to output a LOW
for a TRUE condition.

4.5  Configure frequency outputs
The Frequency Outputs allows you to configure the available frequency outputs for the
meter.
If you previously configured one or more Frequency/Digital outputs, make selections for
the following parameters:
Content:
• Valid outputs are based on Uncorrected (Actual) flow rates.
• Rosemount™ Liquid Ultrasonic meters will also allow you to set the outputs for Profile

Factor.
Direction:
• Reverse: The output only reports flow in the reverse direction. For frequency outputs,

Phase B of the output is 90 degrees out of phase with Phase A.
• Forward: The output only reports flow in the forward direction. For frequency outputs,

Phase B of the output is 90 degrees out of phase with Phase A.
• Absolute: The output reports flow in both directions. For frequency outputs, Phase B of

the output is 90 degrees out of phase with Phase A.
• Bidirectional: The output reports flow on Phase A only in the forward direction and on

Phase B only in the reverse direction.
Maximum frequency output:
• Valid frequency output options are 1000 Hz and 5000 Hz.
The following fields are used to configure the frequency outputs selected to output a
volumetric flow rate. The fields are only enabled if the associated output's content is set to
Uncorrected (Actual).
Full scale volumetric flow rate used with output:
• Enter the flow rate to be equivalent to the maximum frequency of the frequency output.

This property is disabled if Frequency outputs was cleared on the Startup Page.
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K-factor:
A read-only value showing the calculated K-factor from the Full scale volumetric flow
rate used with frequency outputs and the Maximum frequency for frequency output. This
property is disabled if Frequency outputs was cleared on the Startup Page.
Vol/pulse:
A read-only value showing the calculated inverse of the K-factor. This property is disabled if
Frequency outputs was cleared on the Startup Page.
Velocity:
• Maximum scale velocity used with output: Enter the velocity to be equivalent to the

maximum frequency of the frequency output. These values are only enabled if the
Content is set to Average flow velocity or Average sound velocity. This property is
disabled if Frequency outputs was cleared on the Startup Page.

• Minimum scale velocity used with output: Enter the velocity to be equivalent to the
minimum frequency (i.e. 0 Hz) of the frequency output. These values are only enabled
if the Content is set to Average flow velocity or Average sound velocity. This property is
disabled if Frequency outputs was cleared on the Startup Page.

4.6  Outputs test mode
The Rosemount 3810 Liquid Ultrasonic Flow Meters provides a mode of operation for
testing the frequency, current (analog) and digital output signals. Entering, configuring,
and exiting this mode is accomplished by setting data points using the MeterLink Tools → 
Outputs Test.
The Outputs Test dialog box allows you to monitor the live values of all the frequency,
current (analog) and digital outputs. Additionally, the outputs can be set into a Test mode
to force the outputs to a specific user defined value. This dialog box is only available while
connected to a meter.
Procedure

1. When the dialog box first opens, the available Outputs show the current "Live"
values the outputs are driving. The LED Test mode remains gray while not in Test
mode.
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Figure 4-10: Meter Outputs Test Page

Note
The AO2 is only available with CPU module, part number 1-360-03-010.

2. To fix the frequency and current outputs to a user-defined value, enter the
desired percentage of full-scale into the Output setting. For Rosemount 3810 Liquid
Ultrasonic Flow Meters, each available output has individual output control and
can be set from 0 to 150%. The 100% Scaling indicates the full scale value for the
frequency outputs and can be changed from the Field Setup Wizard.
For Rosemount 3810 Liquid Ultrasonic Flow Meters, each available output has
individual output control and can be set from 0 to 150%.
The 100% Scaling indicates the full scale value for the frequency outputs and can be
changed from the Field Setup Wizard.

3. Click the Start button to enter Test mode.
Each output has its own start button, so each available output can be tested one at a
time.
The frequency and current outputs will not be updated until the end of the next
batch cycle.
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Note
The frequency outputs for both the A and B channels are displayed. If Channel B
zero on error is selected in the Field Setup Wizard the Channel B phase will show
zero because the frequency output is considered invalid during test mode.

Note
The K-Factor and Inverse K-Factor will be displayed for the frequency outputs
configured for Volumetric flow rate. The values will be displayed next to the label
for the associated frequency output.
Once the Test mode LED turns green, the output values displayed represent the
values the outputs are driving under test.

4. To set the digital outputs to a known state, select the Test High or Test Low for the
appropriate digital output and click the Start button for the digital output.
Note
The timeout for each output in test mode is reset by MeterLink™ each time the
values are updated. As long as this dialog is open with an output in test mode, the
output will remain in test mode or until the Stop button is clicked to end the test.

Note
In the event communications are lost between MeterLink and the meter (before
a test mode is stopped), the meter will automatically end the test mode after the
NonNormalModeTimeout has expired. This can be from 1 to 30 minutes depending
on its settings. By default, the timeout is set to two minutes.

Once the Test mode LED turns green, the value displayed for the outputs will
represent the values the outputs are driving under test.

5. The Output setting can only be changed while out of Test mode. To end the Test
mode, click Stop and wait for the end of the batch and the Test mode LED to turn
gray to indicate the Outputs are driving live values.

6. Click Cancel to close the dialog box.
If the meter is currently in Test mode when Cancel is clicked, MeterLink will first end
the test mode before returning to the main screen.

4.7  Configure HART® outputs
Configure the HART outputs of the Rosemount Ultrasonic meter. For additional
information, refer to the HART Field Device Specification Manual (00825-0400-3240) .

4.7.1  Configure the four dynamic variables
• Primary - set to match the Content for Current Output 1
• Secondary - set to match the Content for Current Output 2
• Third - select from the following variables: Uncorrected flow rate, Average flow velocity,

Average speed of sound, Pressure and Temperature
• Fourth - select from the following variables: Uncorrected flow rate, Average flow

velocity, Average speed of sound, Pressure and Temperature
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4.7.2  Configure the device identification
Configure the common variables in HART® devices used to identify the particular device.
• Tag - The tag name for the HART device which may be used by host systems to uniquely

identify the meter. The tag may be up to 8 characters in length.
• Long tag - The specified long tag matches that of the meter. The tag may be 32 bytes in

length.
• Date - A 3 byte value where the most significant byte is the day of the month (1-31), the

second byte is the month of the year (1-12), and the third byte is the year-1900.
• Message - A string value that can be no more than 32 characters in length.
• Descriptor - A string value that can be no more than 16 characters in length.
• Final assembly number - A numeric value that must be between 0 and 1677215.
• Polling address - The HART address for the meter. By default, the meter is 0 but the

address can range from 0 to 63.

4.7.3  Configure the HART® units
Configure the units that values will be read in over the HART interface:
• Volume units
• Average speed of sound
• Flow rate time units
• Velocity
• Pressure
• Temperature

4.8  Configure meter corrections
4.8.1  Temperature expansion correction

• Linear expansion coefficient of the meter body material
• Linear expansion coefficient reference temperature

4.8.2  Pressure expansion correction
• Pipe outside diameter: Enter the outside diameter of the meter body.
• Young's modulus: Enter the Young's Modulus value (ratio of tensile stress to tensile

strain).
• Poisson's ratio: Enter the Poisson's Ratio value (the absolute ratio of the pipe material

lateral strain over axial strain).
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4.9  Configure temperature and pressure
4.9.1  Flow-condition temperature and pressure

The flow-condition pressure and temperature are used by the Rosemount 3810 Series
Liquid Ultrasonic Flow Meter for various calculations such as:
• Expansion correction
Configuration
The flow-condition pressure and temperature are individually configurable (via the
EnablePressureInput and EnableTemperatureInput data points) to be:
• Disabled (0)
• Live (1) (4-20 mA input signal)
• Fixed (2)
If an input is live, then the values corresponding to the minimum and maximum
input (4 and 20 mA, respectively) are specified via data points (MinInputPressure,
MaxInputPressure, MinInputTemperature, MaxInputTemperature).
If an input is fixed, then its value is specified via a data point (SpecFlowPressure,
SpecFlowTemperature).
Alarm limits can be specified for each input (LowPressureAlarm, HighPressureAlarm,
LowTemperatureAlarm, HighTemperatureAlarm). Additionally, the flow-condition pressure
is configurable to be gage or absolute (via the InputPressureUnit data point). If
the pressure is gage, then the atmospheric pressure must be specified (via the
AtmosphericPress data point). See Configure the temperature parameters for the meter
and Configure the pressure parameters for the meter for details on configuring the flow-
condition pressure and temperature.
Another data point (FlowPOrTSrcUponAlarm), common to both pressure and temperature,
is used to specify the data source to use when the selected input data is invalid (i.e., value
at or outside its alarm limits or a live input in calibration) as one of the following:
• Last good value (0)
• Fixed value (1)
This data point (FlowPOrTSrcUponAlarm) is configurable via the MeterLink Field Setup
Wizard  → Temperature and Pressure page under Alarm Selection. It is also configurable
via the MeterLink Tools → Edit/Compare Configuration screen. The default is to use the
last good value.
Data updates
The Rosemount 3810 Series Liquid Ultrasonic Flow Meter samples the input
analog signal(s) and updates the corresponding data point(s) (LiveFlowPressure,
LiveFlowTemperature) once per second regardless of the input selection (disabled, live).
Every five seconds, the meter updates the "in-use" flow-condition pressure and
temperature values (FlowPressure, AbsFlowPressure, FlowTemperature) depending upon
the input selection, validity of the input data, and the selected data source upon alarm
according to the following table:
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Table 4-7: Flow-condition pressure and temperature data source
Input Type
(EnablePressureInpu
t or
EnableTemperatureI
nput)

Data Validity
(PressureValidity or
TemperatureValidity )

Data Source Upon
Alarm
(FlowPOrTSrcUponAla
rm )

“In‑Use” Data Source
(FlowPressure or
FlowTemperature)

Disabled N/A N/A “In‑Use” value
unchanged

Live Valid N/A Average of live values
(LiveFlowPressure or
LiveFlowTemperature)

Invalid(1) Last good value “In‑Use” value
unchanged

Fixed Fixed data point
(SpecFlowPressure or
SpecFlowTemperature)

Fixed Valid N/A Fixed data point
(SpecFlowPressure or
SpecFlowTemperature)

Invalid Last good value “In‑Use” value
unchanged

Fixed Fixed data point
(SpecFlowPressure or
SpecFlowTemperature)

(1) Live input can be invalid due to (a) one or more live values is/are at or outside the alarm
limits, or (b) the input is being calibrated.

The flow-condition absolute flow pressure is calculated as shown below:

Equation 4-5: Flow-condition absolute flow pressurePabs, f = Pf+ PAtmospℎereInputPressureUnit = False(Gage)Pabs, f = PfInputPressureUnit = True(Absolute)
where
Pabs,f = flow-condition absolute pressure (MPaa) (AbsFlowPressure)
Pf = flow-condition pressure (MPag if InputPressureUnit=FALSE, MPaa if

InputPressureUnit=TRUE) (FlowPressure)
PAtmosphere= (specified) atmospheric pressure (MPaa) (AtmosphericPress)

4.9.2  Configure the temperature parameters for the meter
• Live temperature – If Live Analog was selected for Temperature for meter corrections

on the MeterLink™ Startup Page, enter the scaling for the transmitter connected to the
analog input. Minimum input is the zero scale temperature of the transmitter (i.e. 1 Volt
or 4 mA). Maximum input is the full scale temperature of the transmitter (i.e. 5 Volts or
20 mA).

• Fixed temperature – If Fixed was selected on the MeterLink Startup Page for
Temperature, it will also be enabled if a live temperature input was selected. Enter a
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fixed value to use for calculations if the live input goes into alarm. Enter an average
temperature of the process fluid.

• Temperature alarm – Enter the low and high alarm limits. A temperature reading
outside of these limits causes a Temperature Validity alarm. The Alarm selection
determines what value to use while a live input is in alarm. This value is common with
the pressure Alarm selection so when one is changed, the other will change to match.

4.9.3  Configure the pressure parameters for the meter
• Pressure reading – Select either Gage or Absolute for the type of pressure reading

desired. If a live pressure transmitter is connected, select the type of reading the
transmitter outputs. If Absolute is selected, you must also enter the Atmospheric
pressure.

• Live pressure – Enter in the scaling for the transmitter connected to the analog input.
Min. input is the zero scale pressure of the transmitter (i.e. 1 Volt or 4 mA). Max. input is
the full scale pressure of the transmitter (i.e. 5 Volts or 20 mA).

• Fixed pressure – Enabled if Fixed was selected for Temperature for meter corrections
on the Startup Page. It will also be enabled if a live temperature input was selected to
allow you to enter a fixed value to use for calculations if the live input goes into alarm.
Enter an average pressure of the process fluid.

• Pressure alarm – Enter the low and high alarm limits. A pressure reading outside
of these limits causes a Pressure Validity alarm. The Alarm selection determines what
value to use while a live input is in alarm. This value is common with the temperature
Alarm selection so when one is changed, the other will change to match.

4.10  Configure reverse flow alarm
Reverse flow alarm
Selecting Enable will configure the meter to generate a reverse flow alarm if it accumulates
more volume in the reverse direction than what is set in the Volume limit.
For flow to be counted as reverse flow for this check, it must be flowing at a velocity about
Low flow limit. This low flow limit is different from the Volume cut-off threshold below
which flow in not counted as flow for volume accumulation. Every time the flow direction
changes from forward to reverse, the reverse flow accumulated volume is reset to zero.
If the meter is a bi-directional meter, this alarm should not be enabled in order to avoid
this alarm becoming active during periods of expected reverse flow.
Alarm limits are specified by the reverse flow volume limit (ReverseFlowVolLmt data point)
and by the reverse flow detection zero flow cutoff (ReverseFlowDetectionZeroCut data
point).
View alarm limits must be selected on the Field Setup Wizard - Startup page to configure
this alarm.
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Figure 4-11: Reverse flow alarm

4.11  Configure local display parameters
Configure the parameters for the local display. Use the Field Setup Wizard dropdown menu
in the Display Items list box and select or modify the Display items, the Display units and
the Scroll delay.
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Figure 4-12: Local display parameters

Configure display items
Local Display label description Valid units
QFLOW - Uncorrected volume flow rate • BBL - Barrels

• GAL - Gallons
• L - Liters
• CM - Cubic Meters
• MCM - Thousand Cubic Meters
• GAL - Gallons
• CM - Cubic Meters

TDYVL - Current day's forward uncorrected volume • +BBL - Barrels
• +GAL - Gallons
• +L - Liters
• +CM - Cubic Meters
• +MCM - Thousand Cubic Meters
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Local Display label description Valid units
TDYVL - Current day's reverse uncorrected volume • -BBL - Barrels

• -GAL - Gallons
• -L - Liters
• -CM - Cubic Meters
• -MCM - Thousand Cubic Meters

YSTVL - Previous day's forward uncorrected volume • +BBL - Barrels
• +GAL - Gallons
• +L - Liters
• +CM - Cubic Meters
• +MCM - Thousand Cubic Meters

YSTVL - Previous day's reverse uncorrected volume • -BBL - Barrels
• -GAL - Gallons
• -L - Liters
• -CM - Cubic Meters
• -MCM - Thousand Cubic Meters

TOTVL - Forward uncorrected volume • +BBL - Barrels
• +GAL - Gallons
• +L - Liters
• +CM - Cubic Meters
• +MCM - Thousand Cubic Meters

TOTVL - Reverse uncorrected volume • -BBL - Barrels
• -GAL - Gallons
• -L - Liters
• -CM - Cubic Meters
• -MCM - Thousand Cubic Meters

VEL - Average flow velocity • Ft/S - Feet per second
• M/S - Meters per second

SOS - Average sound velocity • Ft/S - Feet per second
• M/S - Meters per second

TEMP - Flow-condition temperature • DEGF - Degrees Fahrenheit
• DEGC - Degrees Celsius

PRESS - Flow-condition pressure • PSI - Pound per square inch
• MPA - Megapascals

FRQ1A - Frequency channel 1A • HZ - Hertz

FRQ1B - Frequency channel 1B • HZ - Hertz
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Local Display label description Valid units
KFCT1 - Frequency 1 K-factor • BBL - Barrels

• GAL - Gallons
• L - Liters
• CM - Cubic Meters
• MCM - Thousand Cubic Meters

FRQ2A - Frequency channel 2A • HZ - Hertz

FRQ2A - Frequency channel 2B • HZ - Hertz

KFCT2 - Frequency 2 K-factor • BBL - Barrels
• GAL - Gallons
• L - Liters
• CM - Cubic Meters
• MCM - Thousand Cubic Meters

AO1 - Analog Output 1 current • MA - Milliamperes

AO2 - Analog Output 2 current • MA - Milliamperes

Note
When connected to a meter with the local display option, reverse flow direction is indicated
with a minus sign (negative) before the value(s) shown on the display.

Configure display units
The Meter volume units displayed are either U.S. Customary or Metric. To modify the
Display Units, configure the Meter units system in the Field Setup Wizard – General Page.
• U.S. Customary volume unit selections are:

— Barrels
— Gallons

• Metric volume unit selections are:
— Cubic meters
— Cubic liters

• Display units preceded by a plus or minus sign indicate forward and reverse flow
direction, as shown in the table below.

• The Local Display Flow rate time units are modifiable by selecting the dropdown menu
and clicking the time unit in the list box.

• Valid flow rate time units selections are:
— second
— minute
— hour
— day
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Configure scroll delay
The Scroll Delay is the time interval for the selected display items to be shown on the Local
Display. The default scroll delay setting is five seconds. Click the spin box up or down arrow
to increase or decrease the length of time an item displays.

1. Select Finish to write the configuration settings to the meter.
2. Save the meter configuration file, collect a Maintenance log and Waveforms to

document the “As Left” settings.

4.12  Configure users
Rosemount 3810 Series Firmware v1.60 and later require user authentication to connect to
the meter with MeterLink™.
Meters ship from the factory with a single default user named administrator. The default
password is Administrator-XXXXX where XXXXX is the non-zero padded CPU serial number
which can be found on a label on the CPU Module. It is highly recommended to change
this password on meter startup for cybersecurity reasons. For added security, the default
username, administrator, can be changed as well. See Manage users for more details on
how to add, change, and delete user.

4.13  Save the configuration
Procedure

1. Use the MeterLink™ Tools → Edit/Compare Configuration menu.
2. Enable the View All radio button to display the Extended configuration.

This includes some read-only data points that help describe the meters
configuration. Read-only datapoints are displayed for reference only and cannot
be changed. They are displayed with a gray background for reference only and
cannot be changed. The extended configuration data points are viewable in the
Maintenance Logs Report, Archive Log Report, Flow Calibration, Zero Calibration
dialogs and the Edit/Compare Configuration tool.

3. Enable the View Metrology radio button to display only the metrology portion of the
configuration.
The Metrology View includes the following parameters:
• Path dimensions
• Pipe diameter
• Transducer delay parameters
• Zero flow calibration coefficients
• Flow calibration coefficients

4. Click the Read button to display the meter's configuration parameters.
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Figure 4-13: Edit/Compare Configuration

5. Click Save to open the Save As dialog box.
A default name is provided based on the meter name, time, and date the
configuration was collected. By default, all files are saved in the Data folder directory
defined under Program Settings. You may change the name and directory location if
desired. The entire configuration is saved to file.
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5  Logs/Reports
5.1  Archive logs

The Rosemount™ 3810 Series Liquid Ultrasonic Flow Meters provides five types of data logs:
• Daily log
• Hourly log
• Audit log
• Alarm log
• System log
From Rosemount 3810 Series Firmware v1.42 and later, the meter can store up to 1825
daily records (5 years) and 4320 hourly records (180 days).
Each log type is discussed in detail below followed by MeterLink™ instructions to read (and
optionally save) meter log records (For more information, refer to Options for reading daily
and/or hourly log records).

5.1.1  Daily and hourly log data points actions
Five different log data point actions are supported by the daily and hourly logs: snapshot,
average, flow-gated (average), totalize, and macro as described below:
• SNAPSHOT: Causes the data point's value at the log time to be recorded.
• AVERAGE: Causes the data point's average value over the log interval (day or hour) to

be recorded.
• FLOW_GATED: Average value of the data point over the log interval (day or hour) to

be recorded while the volumetric flow rate (QFlow) is above the volumetric flow rate
threshold (QCutOff). If the volumetric flow rate does not exceed the threshold during
the log interval, then the flow gated average of the data point is the same as the
average value of the data point over the log interval to be recorded.

• FLOW_ANALYSIS_GATED: Average of the data point over the log interval (day or hour)
to be recorded while the average flow velocity (AvgFlow) is between the diagnostic
flow analysis limits (FlowAnalysisLowFlowLmt and FlowAnalysisHighFlowLmt). If the
average flow velocity is not within the limits during the interval, then the flow analysis
gated average of the data point is the same as the average value of the data point over
the log interval to be recorded.

• TOTALIZE: Causes the data point's accumulated value over the log interval (day or hour)
to be recorded.

• MACRO: Causes the (boolean) data point's “latched” value over the log interval (day or
hour) to be recorded. A (boolean) data point's latched value indicates if the point was
ever TRUE during the log interval (where a TRUE value is represented by a 1 and a
FALSE value is represented by a 0). This allows a group of boolean data points to be
grouped into a single integer value where each bit represents the latched value of a
single boolean data point.
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Daily log
The Rosemount™ 3810 Series Liquid Ultrasonic Flow Meter stores a daily log record once
per day at the specified contract hour.
(Refer to the MeterLink™ Help files for information on specifying the ContractHour data
point.)
The user can select whether old, unread records can be overwritten by new records when
the log becomes full via the data point DoOverwriteUnreadDailyLog. This point can be
modified using the MeterLink Tools → Edit/Compare Configuration screen. The default
is to overwrite old, unread records. Refer to Options for reading daily and/or hourly log
records for information on reading records and marking records as read. The data point
IsDailyLogFull indicates whether or not the daily log is full and cannot overwrite old,
unread records.
The data points included in the daily log and the corresponding log action are as shown in
the table below. Data points required by the API Chapter 21 standard are marked with an
asterisk (*). For information on a particular data point, consult MeterLink online help (see
the help topic for any data point in MeterLink. Click Help  → Liquid 3810 Series Registers
Reference, select the Index tab, start typing the data point name until the desired point is
highlighted, and then click the Display button.)
Table 5-1: Daily log data points
Data point Content Log action
PosVolFlow TOTALIZE and SNAPSHOT
NegVolFlow TOTALIZE and SNAPSHOT
AccumFlowTime TOTALIZE
DailyMacro1 MACRO
bit 0 IsQFlowInvalid
bit 1 Unused
bit 2 Unused
bit 3 Unused
bit 4 IsEstimatedFlowVelocityInUse
bit 5 IsTooFewOperChords
bit 6 Unused
bit 7 Unused
bit 8 Unused
bit 9 Unused
bit 10 IsAcqModuleIncompatible
bit 11 IsHourlyLogFull
bit 12 IsDailyLogFull
bit 13 IsAuditLogFull
bit 14 IsAlarmLogFull
bit 15 IsSystemLogFull
bit 16 IsXdcrFiringSyncError
bit 17 IsColocMeterCommErr
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Table 5-1: Daily log data points (continued)
Data point Content Log action
bit 18 Unused
bit 19 Unused
bit 20 IsElecVoltOutOfRange
bit 21 IsElecTempOutOfRange
bit 22 DidCnfgChksumChg
bit 23 DidPowerFail
bit 24 IsAcqModuleError
bit 25 IsAcqMode
bit 26 DidColdStart
bit 27 IsCorePresent
bit 28 WatchDogReset
bit 29 D11
bit 30 IsWarmStartReq
bit 31 lsClkInvalid
DailyMacro2 MACRO
bit 0 Unused
bit 1 Unused
bit 2 Unused
bit 3 Unused
bit 4 Unused
bit 5 IsReverseFlowDetected
bit 6 Unused
bit 7 Unused
bit 8 Unused
bit 9 Unused
bit 10 Unused
bit 11 Unused
bit 12 IsColocMeterSndSpdRangeErr
bit 13 IsColocMeterQFlowRangeErr
bit 14 DidWarmStart
bit 15 DidResetUsers
bit 16 IsAnyLogFull
bit 17 TemperatureInvalid
bit 18 PressureInvalid
bit 19 Unused
bit 20 IsChordLengthMismatched
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Table 5-1: Daily log data points (continued)
Data point Content Log action
bit 21 IsXdcrMaintenanceRequired
bit 22 IsSNRTooLow
bit 23 IsPeakSwitchDetected
bit 24 IsHardFailedD
bit 25 IsHardFailedC
bit 26 IsHardFailedB
bit 27 IsHardFailedA
bit 28 IsMeterVelAboveMaxLmt
bit 29 IsAvgSoundVelRangeErr
bit 30 IsMeasSndSpdRange
bit 31 Unused
DailyMacro3 MACRO
bits 0 - 3 IsChordLengthMismatched<A..D>
bits 4 -7 Unused
bits 8 - 11 IsBatchInactive<A..D>
bits 12 - 15 Unused
bits 16 - 19 IsXdcrMaintenanceRequired<A..D>
bits 20 - 23 Unused
bits 24 - 27 IsFailedForBatch<A..D>
bits 28 - 31 Unused
DailyMacro4 MACRO
bits 0 - 3 DidDltTmChkFail<A..D>
bits 4 -7 Unused
bits 8 - 11 IsSigQltyBad<A..D>
bits 12 - 15 Unused
bits 16 - 19 DidExceedMaxNoise<A..D>
bits 20 - 23 Unused
bits 24 - 27 IsSNRTooLow<A..D>
bits 28 - 31 Unused
DailyMacro5 MACRO
bits 0 - 3 DidDltTmChkFail<A..D>
bits 4 -7 Unused
bits 8 - 11 IsSigDistorted<A..D>
bits 12 - 15 Unused
bits 16 - 19 IsPeakSwitchDetected<A..D>
bits 20 - 23 Unused
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Table 5-1: Daily log data points (continued)
Data point Content Log action
bits 24 - 27 IsSigClipped<A..D>
bits 28 - 31 Unused
DailyMacro6 MACRO
bits 0 - 3 IsMeasSndSpdRange<A..D>
bits 4 -7 Unused
bits 8 - 11 IsStackingIncomplete<A..D>
bits 12 - 31 Unused
ProfileFactor FLOW_GATED
SwirlAngle FLOW_GATED
Symmetry FLOW_GATED
CrossFlow FLOW_GATED
Turbulence<A..D> FLOW_GATED
SndVel<A..D> FLOW_GATED
SpdSndSpread AVERAGE
AvgSndVel FLOW_GATED
SndVelDiff<A..D> FLOW_GATED
AGA10SndVel FLOW_GATED
ColocMeterTH2VsTH1AvgSndVelPctDiff FLOW_GATED
FlowVel<A..D> FLOW_GATED
AvgFlow FLOW_GATED
FlowVelRatio<A..D> AVERAGE
PctGood<A1..D2> AVERAGE
Gain<A1..D2> AVERAGE
SNR<A1..D2> AVERAGE
NoiseAmplitude<A1..D2> AVERAGE
QFlow FLOW_GATED
ColocMeterTH2VsTH1QFlowPctDiff FLOW_GATED
FlowTemperature FLOW_GATED
ExpCorrTemperature FLOW_GATED
FlowPressure FLOW_GATED
ExpCorrPressure FLOW_GATED
AbsFlowPressure FLOW_GATED
Viscosity FLOW_GATED
CnfgChksumValue SNAPSHOT
CnfgChksumDate SNAPSHOT
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Hourly log
The Rosemount™ 3810 Series Liquid Ultrasonic Flow Meter stores an hourly log
record once per hour on the hour. The user can select whether old, unread records
can be overwritten by new records when the log becomes full via the data point
DoOverwriteUnreadHourlyLog.
This point can be modified using the MeterLink Tools → Edit/Compare Configuration
screen. The default is to overwrite old, unread records. Refer to Options for reading daily
and/or hourly log records for information on reading records and marking records as read.
The data point IsHourlyLogFull indicates whether or not the hourly log is full and cannot
overwrite old, unread records.
The data points included in the hourly log and the corresponding log action are as shown
in the table below. Data points required by the API Chapter 21 standard are marked
with an asterisk (*). For information on a particular data point, consult MeterLink™ online
help (see the help topic for any data point in MeterLink. Click Help  → Liquid 3810 Series
Registers Reference, select the Index tab, start typing the data point name until the
desired point is highlighted, and then click the Display button.)
Table 5-2: Hourly log data points
Data point Content Log action
PosVolFlow TOTALIZE and SNAPSHOT
NegVolFlow TOTALIZE and SNAPSHOT
AccumFlowTime TOTALIZE
HourlyMacro1 MACRO
bit 0 IsQFlowInvalid
bit 1 Unused
bit 2 Unused
bit 3 Unused
bit 4 IsEstimatedFlowVelocityInUse
bit 5 IsTooFewOperChords
bit 6 Unused
bit 7 Unused
bit 8 Unused
bit 9 Unused
bit 10 IsAcqModuleIncompatible
bit 11 IsHourlyLogFull
bit 12 IsDailyLogFull
bit 13 IsAuditLogFull
bit 14 IsAlarmLogFull
bit 15 IsSystemLogFull
bit 16 IsXdcrFiringSyncError
bit 17 IsColocMeterCommErr
bit 18 Unused
bit 19 Unused
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Table 5-2: Hourly log data points (continued)
Data point Content Log action
bit 20 IsElecVoltOutOfRange
bit 21 IsElecTempOutOfRange
bit 22 DidCnfgChksumChg
bit 23 DidPowerFail
bit 24 IsAcqModuleError
bit 25 IsAcqMode
bit 26 DidColdStart
bit 27 IsCorePresent
bit 28 WatchDogReset
bit 29 D11
bit 30 IsWarmStartReq
bit 31 lsClkInvalid
HourlyMacro2 MACRO
bit 0 Unused
bit 1 Unused
bit 2 Unused
bit 3 Unused
bit 4 Unused
bit 5 IsReverseFlowDetected
bit 6 Unused
bit 7 Unused
bit 8 Unused
bit 9 Unused
bit 10 Unused
bit 11 Unused
bit 12 IsColocMeterSndSpdRangeErr
bit 13 IsColocMeterQFlowRangeErr
bit 14 DidWarmStart
bit 15 DidResetUsers
bit 16 IsAnyLogFull
bit 17 TemperatureInvalid
bit 18 PressureInvalid
bit 19 Unused
bit 20 IsChordLengthMismatched
bit 21 IsXdcrMaintenanceRequired
bit 22 IsSNRTooLow
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Table 5-2: Hourly log data points (continued)
Data point Content Log action
bit 23 IsPeakSwitchDetected
bit 24 IsHardFailedD
bit 25 IsHardFailedC
bit 26 IsHardFailedB
bit 27 IsHardFailedA
bit 28 IsMeterVelAboveMaxLmt
bit 29 IsAvgSoundVelRangeErr
bit 30 IsMeasSndSpdRange
bit 31 Unused
HourlyMacro3 MACRO
bits 0 - 3 IsChordLengthMismatched<A..D>
bits 4 -7 Unused
bits 8 - 11 IsBatchInactive<A..D>
bits 12 - 15 Unused
bits 16 - 19 IsXdcrMaintenanceRequired<A..D>
bits 20 - 23 Unused
bits 24 - 27 IsFailedForBatch<A..D>
bits 28 - 31 Unused
DailyMacro4 MACRO
bits 0 - 3 DidDltTmChkFail<A..D>
bits 4 -7 Unused
bits 8 - 11 IsSigQltyBad<A..D>
bits 12 - 15 Unused
bits 16 - 19 DidExceedMaxNoise<A..D>
bits 20 - 23 Unused
bits 24 - 27 IsSNRTooLow<A..D>
bits 28 - 31 Unused
HourlyMacro5 MACRO
bits 0 - 3 DidDltTmChkFail<A..D>
bits 4 -7 Unused
bits 8 - 11 IsSigDistorted<A..D>
bits 12 - 15 Unused
bits 16 - 19 IsPeakSwitchDetected<A..D>
bits 20 - 23 Unused
bits 24 - 27 IsSigClipped<A..D>
bits 28 - 31 Unused
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Table 5-2: Hourly log data points (continued)
Data point Content Log action
HourlyMacro6 MACRO
bits 0 - 3 IsMeasSndSpdRange<A..D>
bits 4 -7 Unused
bits 8 - 11 IsStackingIncomplete<A..D>
bits 12 - 31 Unused
ProfileFactor FLOW_GATED
SwirlAngle FLOW_GATED
Symmetry FLOW_GATED
CrossFlow FLOW_GATED
Turbulence<A..D> FLOW_GATED
SndVel<A..D> FLOW_GATED
SpdSndSpread AVERAGE
AvgSndVel FLOW_GATED
SndVelDiff<A..D> FLOW_GATED
ColocMeterTH2VsTH1AvgSndVelPctDiff FLOW_GATED
FlowVel<A..D> FLOW_GATED
AvgFlow FLOW_GATED
FlowVelRatio<A..D> AVERAGE
PctGood<A1..D2> AVERAGE
Gain<A1..D2> AVERAGE
SNR<A1..D2> AVERAGE
NoiseAmplitude<A1..D2> AVERAGE
QFlow FLOW_GATED
ColocMeterTH2VsTH1QFlowPctDiff FLOW_GATED
FlowTemperature FLOW_GATED
ExpCorrTemperature FLOW_GATED
FlowPressure FLOW_GATED
ExpCorrPressure FLOW_GATED
AbsFlowPressure FLOW_GATED
Viscosity FLOW_GATED
CnfgChksumValue SNAPSHOT
CnfgChksumDate SNAPSHOT

Audit log
The Rosemount 3810 Liquid Ultrasonic Flow Meters stores an audit log record whenever
any parameter affecting the flow measurement is modified. The audit log record indicates
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which data point changed, the date and time of the change, and both the “as-found” and
“as-left” values.
The meter can store up to 3000 audit records. The user can select whether old, unread
records can be overwritten by new records when the log becomes full through the data
point DoOverwriteUnreadAuditLog. This point can be modified using the MeterLink Tools 
→ Edit/Compare Configuration screen. The default is to overwrite old, unread records.
Refer to Options for reading audit, alarm, and/or system log records for information on
reading records and marking records as read. The data point IsAuditLogFull indicates
whether or not the audit log is full and cannot overwrite old, unread records.
The data points monitored and collected for the audit log are as shown in Audit log
through Event log: alarm/audit. The points are grouped and, within each group, are listed
alphabetically.
The groupings are as follows:
• Calibration
• Chord Proportions
• Co-located meter
• Communications
• Data Logging
• Expansion Correction
• Flow analysis
• Frequency, Digital, and Analog Signals
• General
• HART®

• Indicators
• Local display
• Meter Information
• Pressure & Temperature
• Reynolds Number Calculation
• Signal Processing
• Tracking
For information on a particular data point, consult MeterLink™ online help.
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Table 5-3: Audit log calibration group monitored data points
Data group Data point

AvgDly<A..D>
CalFlag
CalMethod
DltDly<A..D>
Fwd<A0..A3>
FwdA0HighViscosity
FwdFlwRt<1..12>
FwdMtrFactr
FwdMtrFactr<1..12>
FwdMtrFctrHighViscosity<1..12>
FwdProfileFactor<1..12>
HighViscosityMethod
L<A..D>
MeterHousingLength<A..D>
PipeDiam
Rev<A0..A3>
RevA0HighViscosity
RevFlwRt<1..12>
RevMtrFctr<1..12>
RevMtrFctr
RevMtrFctrHighViscosity<1..12>
RevProfileFactor<1..12>
SystemDelay
Wt<A..D>
X<A..D>
XdcrHousingLength<A..D>
XdcrHousingSerialNumber<A..D>
ZeroFlowCalReqControl
ZeroFlowCalReqDuration

Table 5-4: Audit log Chord proportions group monitored data points
Data group Data point

LowFlowLmt
NumVals
PropUpdtSeconds
ResetProp

Table 5-5: Audit log collocated meter group monitored data point
Data group Data point

ColocMeterIPAddress
ColocMeterMode
ColocMeterQFlowErrLimit
ColocMeterRunningAverageInterval
ColocMeterSndSpdErrLimit
IsColocMeterClockSyncEnabled
IsColocMeterQFlowRangeCheckEnabled
IsColocMeterSndSpdRangeCheckEnabled
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Table 5-6: Audit log communication group monitored data point
Data group Data point

BaudPort<A..C>
CommRspDlyPort<A..C>
CommTCPMaxDatagramSizePort<A..C>
CommTimeoutPort<A..C>
DriveSelectionPort<A..C>
Eth1AltMapfilePt
Eth1AltModbusPort
Eth1AltModbusReadWriteMode
Eth1DfltGatewayAddr
Eth1IPAddr
Eth1MapfilePt
Eth1ModbusID
Eth1ModbusReadWriteMode
Eth1SubnetMask
FTPServerControlPort
HTTPServerPort
IsHWFlowControlEnabledPortA
IsTelnetServerEnabled
MaxConnDBAPI
ModbusIDPort<A..D>
PortAMapfilePt
PortBMapfilePt
PortCMapfilePt
ProtocolPort<A..C>
PTPDomainNumber
ReadWriteModePort<A..C>
RTSOffDelayPortA
RTSOnDelayPortA

Table 5-7: Audit log data logging group monitored data point
Data group Data point

AlarmTurnOffHysterisisCount
AlarmTurnOffHysterisisTimeSpan
ContractHour
DailyLogInterval
DoOverwriteUnreadAlarmLog
DoOverwriteUnreadAuditLog
DoOverwriteUnreadDailyLog
DoOverwriteUnreadHourlyLog
DoOverwriteUnreadSystemLog
HourlyLogInterval
IsAuditLogFixedDataPointsEnabled
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Table 5-8: Audit log Expansion correction group monitored data point
Data group Data point

EnableExpCorrPress
EnableExpCorrTemp
LinearExpansionCoef
PipeOutsideDiameter
PoissonsRatio
RefPressExpCoef
RefTempLinearExpCoef
YoungsModulus

Table 5-9: Audit log Flow analysis group monitored data point
Data group Data point

FlowAnalysisHighFlowLmt
FlowAnalysisLowFlowLmt
ReverseFlowDetectionZeroCut
ReverseFlowVolLmt
SwirlAngleLmt
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Table 5-10: Audit log frequency, digital, and analog group monitored data , section 1
Data group Data point

AO1ActionUponInvalidContent
AO1Content
AO1CurrentTrimGain
AO1CurrentTrimZero
AO1Dir
AO1FullScaleVolFlowRate
AO1TestModeOutputPercent
AO1TrimCurrent
AO1TrimGainExtMeasCurrent
AO1TrimZeroExtMeasCurrent
AO1ZeroScaleVolFlowRate
AO2ActionUponInvalidContent
AO2Content
AO2CurrentTrimGain
AO2CurrentTrimZero
AO2Dir
AO2FullScaleVolFlowRate
AO2TestModeOutputPercent
AO2TrimCurrent
AO2TrimGainExtMeasCurrent
AO2TrimZeroExtMeasCurrent
AO2ZeroScaleVolFlowRate
DI1IsInvPolarity
DI1Mode
DO1AContent ... DO1BContent
DO1AIsInvPolarity ... DO1BIsInvPolarity
DO1PairTestEnable
DO2AContent ... DO2BContent
DO2AIsInvPolarity... DO2BIsInvPolarity
DO2PairTestEnable
FODO1Mode
FODO1Source
FODO2Mode
FODO2Source
FODO3Mode
FODO3Source
FODO4Mode
FODO4Source
FODO5Mode
FODO5Source
FODO6Mod
FODO6Source
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Table 5-11: Audit log frequency, digital, and analog group monitored data, section 2
Data group Data point

Freq1BPhase
Freq1Content
Freq1Dir
Freq1FeedbackCorrectionPcnt
Freq1FullScaleVolFlowRate
Freq1MaxFrequency
Freq1TestModeOutputPercent
Freq1ZeroScaleVolFlowRate
Freq2BPhase
Freq2Content
Freq2Dir
Freq2FeedbackCorrectionPcnt
Freq2FullScaleVolFlowRate
Freq2MaxFrequency
Freq2TestModeOutputPercent
Freq2ZeroScaleVolFlowRate
IsAO1EnableTest
IsAO2EnableTest
IsDI1ForCalActiveLow
IsDI1ForCalStateGated
IsFreq1BZeroedOnErr
IsFreq1EnableTest
IsFreq2BZeroedOnErr
IsFreq2EnableTest
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Table 5-12: Audit log general group monitored data point
Data group Data point

AlarmDef
AsyncEnable
AvgSoundVelHiLmt
AvgSoundVelLoLmt
ChordalConfig
ChordInactv<A..D>
DampEnable
DeviceNumber
DitherEnable
FlowDir
IsPlaybackSimulationEnabled
MaxNoDataBatches
MeterMaxVel
MinChord
MinPctGood
NonNormalModeTimeout
PeakSwitchDetectModeSimFileName
PerfStatusSuppressLmt
RTCSecondsSinceEpochSet
SimFileName
SSMax
SSMin
UnitsSystem
UserChanged
VelHold
VolFlowRateTimeUnit
VolUnitMetric
VolUnitUS
XdcrFiringSync
XdcrMaintenanceGainRange
XdcrMaintenanceSNRRange
XdcrType
ZeroCut
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Table 5-13: Audit log HART® data group monitored data point
Data group Data point

HARTDate
HARTDescriptor
HARTDeviceFinalAssyNum
HARTLengthUnit
HARTLongTag
HARTMessage
HARTMinNumPreambles
HARTNumPreambleBytesFromSlave
HARTPollingAddress
HARTPressureUnit
HARTQVContent
HARTRateTimeUnit
HARTSlot0Content
HARTSlot1Content
HARTSlot2Content
HARTSlot3Content
HARTTag
HARTTemperatureUnit
HARTTVContent
HARTVelUnit
HARTViscosityUnit
HARTVolUnit
HARTYoungsModulusPressureUnit
IsHARTSlaveEnabled

Table 5-14: Audit log indicators group monitored data point
Data group Data point

CnfgChksumDate
CnfgChksumValue
DidCnfgChksumChg
DidColdStart
DidPowerFail
DidWarmStart
DoWarmStart
IsConfigProtected
IsCorePresent
IsProgrammingStarted
MeterResetTime
WatchDogReset

Table 5-15: Audit log local display group monitored data point
Data group Data point

LocalDisplayFlowRateTimeUnit
LocalDisplayItem<1..10>
LocalDisplayMode
LocalDisplayScrollDelay
LocalDisplayVolUnitMetric
LocalDisplayVolUnitUS
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Table 5-16: Audit log meter information group monitored data point
Data group Data point

Address
City
CPUBdBootLoaderSwVer
CPUBdSwVer
FileSysVer
MeterName
MeterSerialNumber
OSVer
StateAndCountry
StationName
UserScratch1
UserScratch2

Table 5-17: Audit log pressure and temperature group monitored data point
Data group Data point

AtmosphericPress
EnablePressureInput
EnableTemperatureInput
FlowPOrTSrcUponAlarm
FlowPressureWhileCal
FlowTemperatureWhileCal
HighPressureAlarm
HighTemperatureAlarm
InputPressureUnit
LiveFlowPressureCalCtrl
LiveFlowPressureGain
LiveFlowPressureOffset
LiveFlowTemperatureCalCtrl
LiveFlowTemperatureGain
LiveFlowTemperatureOffset
LowPressureAlarm
LowTemperatureAlarm
MaxInputTemperature
MinInputPressure
MinInputTemperature

Table 5-18: Audit log Reynolds number calculation group monitored data point
Data group Data point

Viscosity
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Table 5-19: Audit log signal processing group monitored data point
Data group Data point

BatchPercentSmoothing
BatchSize
CRange
DltChkSI
EmRateActual
EmRateDesired
Filter
FireSeq
GainHighLmt
GainLowLmt
MaxHoldTm
MaxNoise
MinHoldTime
MinSigQlty
NegSpan
Pk1Pct
Pk1Thrsh
PkPlsWdthSI
PosSpanSI
SampInterval
SampPerCycle
SetXdcrType
SndSpdChkMaxVel
SndSpdChkMinVel
SNRatio
SpecBatchUpdtPeriod
StackEmRateActual
StackEmRateDesired
StackSize
TmDevFctr1
TmDevLow1SI
XdcrFreq
XdcrNumDriveCycles
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Table 5-20: Audit log tracking group monitored data point
Data group Data point

ResetTrkParam
Tamp
TampHi
TampLo
TampSen
TampWt
Tspe
TspeHi
TspeLmt
TspeLo
TspeSen
TspeWt
Tspf
TspfHi
TspfLo
TspfMatch
TspfSen
TspfWt

Table 5-21: Audit log Fixed data points
Data group Data point
Fixed value configuration data points, which are written by external client like a flow computer at
regular interval of time, can be enabled by setting IsAuditLogFixedDataPointsEnabled as TRUE.
By default, IsAuditLogFixedDataPointsEnabled is set to FALSE which disables audit logging of the
following data points.
Inputs SpecFlowTemperature

SpecFlowPressure

Determining meter power-up and power-down times
The audit log can be used to determine the meter start (or re-start) time and the
meter power-down time by examining the MeterResetTime record(s). The MeterResetTime
record time stamp indicates (to within a few seconds) the time that the meter was started.
The As-left value indicates the time (to within a few seconds) that the meter was powered-
down.

5.1.2  Event log: alarm/audit
The meter monitors several data points with respect to each point's alarm limit(s). Non-
boolean data points can have low and high alarm limits. Boolean data points only have a
single alarm limit (i.e., either TRUE or FALSE).
There are two statuses associated with alarms: set and cleared. An alarm is set when the
data point is at or exceeds its alarm limit. An alarm is cleared when the data point is within
its alarm limit(s).
The Rosemount™ 3810 Series Ultrasonic Flow Meter stores an alarm log record whenever
any monitored data point's alarm status (cleared or set) changes. The alarm log record
indicates the data point, date and time, alarm status, corresponding alarm limit, and data
point value.
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The meter can store up to 3000 alarm records. The user can select whether old, unread
records can be overwritten by new records when the log becomes full via the data point
DoOverwriteUnreadAlarmLog. This point can be modified using the MeterLink Tools  → 
Edit/Compare Configuration screen. The default is to overwrite old, unread records. Refer
to Options for reading audit, alarm, and/or system log records for information on reading
records and marking records as read. The data point IsAlarmLogFull indicates whether or
not the alarm log is full and cannot overwrite old, unread records.
The user-settable data points AlarmTurnOffHysterisisCount and
AlarmTurnOffHysterisisTimeSpan are used to prevent very repetitive alarms from filling
up the alarm log. When an alarm is set AlarmTurnOffHysterisisCount times within
AlarmTurnOffHysteresisTimeSpan seconds, then the alarm is suppressed until the alarm
frequency drops below the specified rate (counts per time span) at which point the next
alarm clearing "unsuppresses" the alarm. The alarm log records indicate when an alarm
suppression is started and ended. The default values are 8 occurrences in 240 seconds.
The data points monitored for the alarm log are as shown in the tables below. Note that
the alarm limits are themselves data points. The user-settable alarm limits are listed by
data point name. Non-settable alarm limits are listed by data point value.
Table 5-22: Alarm log monitored data points
Data point Low alarm limit High alarm limit
GainA1, GainA2,
GainB1, GainB2,
GainC1, GainC2,
GainD1, GainD2,

GainLowLmt GainHighmit

AvgSndVel AvgSoundVelLoLmt AvgSoundVelHiLmt
SpecFlowPressure LowPressureAlarm HighPressureAlarm
SpecFlowTemperature LowTemperatureAlarm HighTemperatureAlarm
LiveFlowPressure LowPressureAlarm HighPressureAlarm
LiveFlowTemperature LowTemperatureAlarm HighTemperatureAlarm
AvgFlow MeterMaxNegVel MeterMaxVel
SysTemp -40 °C 100 °C
SysVoltage1V 0.90 V 1.10 V
SysVoltage1V2 1.08 V 1.32 V
SysVoltage2V5 2.225 V 2.775 V
SysVoltage3V3 2.937 V 3.663 V

Table 5-23: Alarm log Boolean alarm limit
Data point Boolean alarm unit
IsClkInvalid TRUE
SpecFlowTemperature TRUE
SpecFlowPressure TRUE
PressureInvalid TRUE
TemperatureInvalid TRUE
IsAcqModuleError TRUE
AvgFlow TRUE
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Table 5-23: Alarm log Boolean alarm limit (continued)
Data point Boolean alarm unit
IsMeterVelAboveMaxLmt TRUE
AvgSndVel TRUE
IsAvgSoundVelRangeErr TRUE
QMeterValidity FALSE
QFlowValidity FALSE
DidColdStart TRUE
IsMeasSndSpdRange<A..D> TRUE
IsAcqMode TRUE
IsTooFewOperChords TRUE
IsHardFailed<A..D> TRUE
Freq1DataValidity FALSE
Freq2DataValidity FALSE
SysTemp TRUE
SysVoltage2V5 TRUE
SysVoltage3V3 TRUE
IsHourlyLogFull TRUE
IsDailyLogFull TRUE
IsAuditLogFull TRUE
IsSystemLogFull TRUE
IsAcqModuleIncompatible TRUE
LiveFlowPressure TRUE
LiveFlowTemperature TRUE
AO1IsSaturated TRUE
AO2IsSaturated TRUE
AO1DataValidity FALSE
AO2DataValidity FALSE
HARTTVValidity FALSE
HARTQVValidity FALSE
HARTSlot0Validity FALSE
HARTSlot1Validity FALSE
HARTSlot2Validity FALSE
HARTSlot3Validity FALSE
AreSwComponentsCompatible TRUE
IsAcqModuleErrorLatched TRUE
IsAcqModeLatched TRUE
IsTooFewOperChordsLatched TRUE
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Table 5-23: Alarm log Boolean alarm limit (continued)
Data point Boolean alarm unit
TemperatureInvalidLatched TRUE
PressureInvalidLatched TRUE
IsMeterVelAboveMaxLmtLatched TRUE
IsAvgSoundVelRangeErrLatched TRUE
IsReverseFlowDetected TRUE
ReverseFlowVol TRUE
IsReverseFlowDetectedLatched TRUE
SysVoltage1V2 TRUE
SysVoltage1V TRUE
SysVoltageAcqModule1V2 TRUE
SysVoltageAcqModule2V5 TRUE
SysVoltageAcqModule3V3 TRUE
SysTempAcqModule TRUE
IsXdcrFiringSyncError TRUE
IsColocMeterCommErr TRUE
IsColocMeterCommErrLatched TRUE
IsColocMeterSndSpdRangeErr TRUE
IsColocMeterSndSpdRangeErrLatched TRUE
IsColocMeterQFlowRangeErr TRUE
IsColocMeterQFlowRangeErrLatched TRUE
IsChordLengthMismatched<A..D> TRUE
DidResetUsers TRUE

System log
The Rosemount 3810 Series Liquid Ultrasonic Flow Meter meter logs all system messages
in the system log.
The meter can store up to 3000 system records. The user can select whether old, unread
records can be overwritten by new records when the log becomes full through the data
point DoOverwriteUnreadSystemLog.
This point can be modified using the MeterLink Tools →  Edit/Compare Configuration
screen. The default is to overwrite old, unread records. Refer to Options for reading audit,
alarm, and/or system log records for information on reading records and marking records
as read. The data point IsSystemLogFull indicates whether or not the system log is full and
cannot overwrite old, unread records.
Repetitive system messages are prevented from filling up the system log. When a
particular system message occurs three times within 60 seconds, that system message
is suppressed until that message's frequency drops below the 3 times-per-60 seconds rate.
The system log records indicate when a system message suppression has started and
ended.
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5.1.3  Reading log records
Rosemount 3810 Series Ultrasonic Flow Meter log records are read using the MeterLink
Logs/Reports → Meter Archive Logs screen.
There are three log groups:
• Daily
• Hourly
• Event (audit, alarm, and systems logs)
Select the desired log group(s) via the Collect daily log/Collect hourly log/Collect event
log check boxes. If the event group is selected, the audit, alarm, and system logs are
individually selectable. Whenever any log is collected, the current meter configuration is
also collected.

5.1.4  Options for reading daily and/or hourly log records
The options for reading daily and hourly log records are the same. The MeterLink Logs/
Reports → Meter Archive Logs screen indicates the number of daily records that are
available to read. Select the log type(s) to be collected via the Collect daily log and/or
Collect hourly log check boxes.
Select whether to collect all log records or the last specified number of daily records. Also,
select whether to collect all log data or just the data points required by the API Chapter 21
standard.

For both tables, data points required by the API Chapter 21 standard are marked with an
asterisk (*).

5.1.5  Options for reading audit, alarm, and/or system log
records
The options for reading audit, alarm, and system log records are the same. The MeterLink™

Logs/Reports → Meter Archive Logs screen indicates the number of records available for
each log type. Select whether to collect either all the records or just the last specified
number of daily records for the selected log type.

5.1.6  Collecting and viewing log records
Three log formats are available:
• Microsoft Excel - This is the recommended format for collecting/saving log records in

order to get the full benefits of the data logging feature. This option, however, is only
available if Microsoft® Excel® is installed on the PC. The Excel® file generated by this
utility has up to six worksheets depending upon the logs collected, including:
— Daily Log
— Hourly Log
— Alarm Log
— Audit Log
— System Log
— Meter Config
The collected log data is also displayed on the screen.
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• Comma-separated values - This format creates a file with data separated by commas.
Each log record collected is put on a separate line in the file. Each log type is separated
by a blank line. The meter configuration follows the log data separated by a blank line.
The collected log data is also displayed on the screen.

• Don't log to file - This option will not save any of the collected log data to a file but will
display it on the screen.
1. After selecting the desired log type(s) and the log format, click on the Collect button

to initiate the log data collection.
• If a format that saves the data to a file is selected, then a Save As dialog box is

opened to allow specifying the file name. A default file name is suggested but
can be modified. A comment may also be entered to be included with the data
file.

2. If a log type to be read is configured so that unread records are not over-written,
then MeterLink™ queries the user as to whether or not that log's records will be
marked as 'read'.

3. Once the data collection is completed, the data is displayed in the Meter Archive
Logs dialog box one log type at a time. Select the log type to be displayed via the
View log box. The data may be sorted by selecting either Oldest first or Newest first
in the Sort order box.

5.1.7  Collecting logs
To collect Maintenance and Trend Logs for meter diagnostics:
Procedure

1. Establish communication with the meter through MeterLink™.
2. From MeterLink main window, select Logs/Reports → Maintenance Logs and

Reports. The Maintenance Logs and Reports dialog displays.
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Figure 5-1: Liquid Maintenance Logs

3. Set the log collection Duration (mins) (2 minutes is the default value which is
normally adequate to capture a good snapshot of the meter's current diagnostic
parameters). To get a good representation of the meter performance, it is
recommended that there be at least 30 records (lines of data). The actual number
of records collected are a function of the type of communication (Serial or Ethernet),
Stack Size (if stacking is turned on), and the Collection speed selected. The duration
value can be changed by clicking the number in the display/edit box and entering a
new value.

4. If desired, a comment may be included in the log file by entering it in the display/
edit box provided.

5. In the Log Format field, select Microsoft® Excel®. Only select Comma Separated
Values (CSV) if the Microsoft Excel option is unavailable, as this format is not
compatible with the generation of graphics, trending and analysis offered by 3810
Series Liquid Ultrasonic Flow Meters. Once the file is collected in the CSV format, it
can not be converted to a Microsoft® Excel® format.

6. To begin collecting logs, click the Start button. MeterLink collects the meter's
configuration and then begins collecting all the data from the meter.

7. MeterLink displays the Log Complete message box after the logs are collected.
8. To view the Microsoft® Excel® file, select YES to open the Workbook.
9. Select the Workbook report view from the Microsoft® Excel® toolbar at the bottom

of the page. Tab selections include:
• Charts
• Inspection Report
• Meter Config
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• Raw Data

Figure 5-2: Microsoft® Excel ® report view toolbar

10. Inspection Report is the default view when you open the Maintenance Log.

11. Charts is the view of charted data.

Figure 5-3: Microsoft® Excel ® charts view

12. The next Microsoft® Excel® report view is Meter Config.
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Figure 5-4: Microsoft® Excel® Meter Config. view

13. The last Microsoft® Excel® report view is Raw Data.

Figure 5-5: Microsoft® Excel® Raw Data view

5.1.8  Collect meter archive logs
This utility allows you to collect historical log information from an ultrasonic meter. This
dialog box is only available while connected to a meter.
Procedure

1. Select the checkboxes for the types of logs you want to collect, as well as the other
options.
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All of the logs will be collected into a single Archive log file.

Figure 5-6: Meter Archive Logs

The Log format can be selected as either Microsoft® Excel, comma-separated values,
or Don't log to file by selecting the appropriate radio button.
Note
The Don't log to file option does not save any of the log data to file; it only displays it
on the screen.

2. Click Collect.
3. In the Save As dialog box, a default name based on the meter name, type of logs

collected, and PC date and tiime is provided. If you choose, you can modify the
default name and location for the file.

5.1.9  Reading Hourly and Daily log records over Modbus (only
available in firmware v1.70 and later)
Log Registers
Flow computers/RTUs can read hourly and daily log records in the meter via the Modbus
protocol. Reading a single hourly or daily log record requires multiple polls since the log
record data cannot fit in a single Modbus response. Meter supports reading one hourly
or daily log record at a time. Multiple clients can read an hourly or daily log record
simultaneously.
Hourly and daily log record data is split into groups and each group is mapped to a
Modbus register. Meter includes a series of registers for reading hourly and daily log
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record. To read a complete log record, a Modbus client should read all log registers
defined for the log record one after the other.
Register # Register Description Liquid 2-path Liquid 4-path
7201 Hourly Log Register for Common data points Yes Yes
7202 Hourly Log Register for Gas composition data

points
Undefined Undefined

7203 Hourly Log Register for Chord A data points Yes Yes
7204 Hourly Log Register for Chord B data points Yes Yes
7205 Hourly Log Register for Chord C data points Yes Yes
7206 Hourly Log Register for Chord D data points Yes Yes
7207 - 7210 Undefined
7211 Hourly Log Register for Accumulator snapshot

data
Yes Yes

7212 - 7224 Reserved for future use
7226 Daily Log Register for Common data points Yes Yes
7227 Daily Log Register for Gas composition data

points
Undefined Undefined

7228 Daily Log Register for Chord A data points Yes Yes
7229 Daily Log Register for Chord B data points Yes Yes
7230 Daily Log Register for Chord C data points Yes Yes
7231 Daily Log Register for Chord D data points Yes Yes
7232 - 7235 Undefined
7236 Daily Log Register for Accumulator snapshot

data
Yes Yes

7237 - 7249 Reserved for future use

Note
These registers can also be read at +40001 offset registers like 7201 at 47202, 7202 at
47203 and so on.
Data contents of each group are documented in the “Hourly and daily archive log
registers” section of the Modbus map PDF available at 3810 Modbus Map Reference Manual
(00821-0100-3810).
UnitsSystem data point configuration must be appropriately set to the unit, US Customary
or Metric units, in which log data must be read. Meter includes the log sequence number,
date, and timestamp in the response of each Modbus log register read operation which
helps to know whether multiple sequential polls are done for the same log record or not.
Date in the response is a 32-bit integer value in YYYYMMDD format and timestamp is also a
32-bit integer value in HHMMSS format.
Below is an example to read hourly log register for chord A data.
Note
Request and response data in the examples is in RTU data format.

Request
For reading log registers, function code 03 is used.
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Request register #7203 (1C23 hex) for the hourly log register for Chord A data points. Field:
Quantity of registers must specify the log index in hourly log table whose data must be
read.
Below command is requesting the hourly log register for Chord A data for log index 30
from the hourly log table from slave device with address 32.
20 03 1C23 001E 3529
20: Slave address
03: Function code
1C23: Hourly log register for Chord A data (1C23 hex = 7203 decimal)
001E: Log index of 30
3529: CRC
Response
Meter’s response to the hourly log register for Chord A data read is as below.
20 03 3C 00 00 10 FF 01 34 D8 1B 00 01 11 70 3D 47 D5 FE 44 B8 EE CB BF E4 31 CD 40 BF
5A CC 3F 80 AD 46 00 64 00 64 42 C7 14 CC 42 C7 14 CC 42 68 58 05 42 66 00 18 3B C7 D6
BB 3B E0 A9 04 72 11
20: Slave address
03: Function code
3C: Data bytes to follow in the response excluding CRC bytes (3C hex = 60 decimal)
00 00 10 FF: Sequence number
01 34 D8 1B: Date
00 01 11 70: Time
3D 47 D5 FE: TurbulenceA
44 B8 EE CB: SndVelA
BF E4 31 CD: SndVelDiffA
40 BF 5A CC: FlowVelA
3F 80 AD 46: FlowVelRatioA
00 64: PctGoodA1
00 64: PctGoodA2
42 C7 14 CC: GainA1
42 C7 14 CC: GainA2
42 68 58 05: SNRA1
42 66 00 18: SNRA2
3B C7 D6 BB: NoiseAmplitudeA1
3B E0 A9 04: NoiseAmplitudeA2
72 11: CRC
Meter shall respond with zero for requests to read log registers that are not applicable
to the device type. For example, if reading hourly log register for Chord C data (7205) is
requested on 3412 meter, then meter will respond with 0.
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Exception Response
If a log register read request is made for a log index at which there is no log record in the
log table, or if the log index is invalid, then meter will return error response: Illegal data
value.
20 83 03
20: Slave address
83: Function code
03: Exception code Illegal Data Value

Log Index Registers
Flow computers/RTUs can also read the log index of the most recently generated hourly
or daily log record in the meter. Log index is the index of a circular buffer where the
most recently generated log record is written. Meter supports maximum of 4320 hourly log
records and 1825 daily log records. Hence the hourly log index can have values from 1 to
4320 and daily log index from 1 to 1825. Meter has two Modbus registers to read log index
for hourly and daily log table.
Register # Register Description
7200 Hourly Log Index Register
7225 Daily Log Index Register

Client can periodically read this index and store it locally. They can know when it has new
log records to read from the meter. Knowing the log index of the most recently generated
log record, client can read any available log record from the meter. If meter returns log
index as zero it means that the log table is empty i.e., there are no log records for the log
type in the meter.
Below is an example to read the daily log index register. Note that request and response
data in the examples is in RTU data format.
Request
For reading the log index registers function code 03 is used.
Request register #7225 (1C39 hex) for the daily log index register. Field: Quantity of
registers must specify 1 since the log index register is INT type.
Below command is requesting the log index of most recently generated daily log record in
the daily log table from slave device with address 32.
20 03 1C39 0001 5526
20: Slave address
03: Function code
1C39: Daily log index (1C39 hex = 7225 decimal)
0001: 1 register to read
5526: CRC
Response
Meter’s response to the daily log index register read is as below.
20 03 02 027E 8503
20: Slave address
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03: Function code
02: Bytes to follow in response excluding CRC
027E: Read log index of the most recently generated daily log record in the meter (027E
hex = 638 decimal)
8503: CRC
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6  Tools commands utility
6.1  Tools menu

The MeterLink™ Tools menu commands provides the following utilities for the meter’s
health status, monitoring operational conditions, the meter’s flow characteristics, updating
the meter’s program components and monitoring communications between MeterLink
and the meter.
Table 6-1: Tools menu commands
Edit/Compare Configuration Open, edit, and compare configurations from files and meters
Edit/Compare Configuration Open, edit, and compare configurations from files and meters.
Waveform Viewer Collect, view, save, print ultrasonic waveforms from meter or file.
Outputs Test Test frequency, current, and digital outputs by fixing them to a set

value.
Transducer Swap-Out Adjust path length parameters when changing out transducers,

stalks, holders, or mounts.
Set Baseline Wizard Establishes the baseline for the meter's flow characteristics that can

be used to monitor the heath of the meter run using Continuous
Flow Analysis features.

Program Download Upgrade the program components in Rosemount Ultrasonic meters.
Communications Analyzer Monitor communications between MeterLink and a meter.

6.1.1  Edit/Compare Configuration parameters
This MeterLink™ command utility is used to:
• Open
• Edit
• Compare configurations from files and meters
• Write parameter changes to the meter
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Figure 6-1: Edit/Compare configuration parameters

Edit the meter's configuration parameters
Prerequisites
This dialog’s options include:
• View and edit configurations collected from the meter or opened from a file
• Write all or a portion of changed parameters of a configuration to a connected meter
• Comparing and converting legacy configurations
• Save and Print configurations

Figure 6-2: Edit/Compare configuration parameters
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Procedure
1. Click Read to collect and display a configuration from a connected meter.
2. Click ALL to display the meter’s extended configuration or Metrology to display only

the metrology portion of the configuration.
3. Double-click the Value to change a parameter and select the option from the drop-

down list or if a caret is displayed, enter the value.
If you change a data register, the Value displayed in the dialog turns yellow and
the check box is selected. You can later choose to only Write Checked values to the
meter.

Figure 6-3: Configuration changes

4. Click the question mark icon to the right of a data point to display the additional
information.

5. Click Write All to write the full configuration to a meter. Depending on the View
selected, the displayed configuration may not be the full configuration. Click Write
Checked to write only the values with a selected check box next to the value and are
visible in the currently selected view. Select any values to write and clear any values
you don’t want to write to the meter before clicking Write Checked.

6. Open a configuration in the editor and select Meter or select File to compare it to a
configuration saved as a file.

7. Click Compare to either read the configuration from the meter or open the Open
dialog box to select the configuration to compare to the one in the editor.

a. Exclude registers that are typically different: Includes items
that could change regularly. A complete list is defined in
reg_list_compare_config_exclude.txt found under the installation directory for
MeterLink™.

b. Include read-only registers: Includes, in the compare, read-only registers
stored in the collected configurations. This includes points like firmware
version, K-factors, etc.
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Once the configurations are selected, a dialog displays, providing options to further
customize the compare operation.

8. Click Save to save the configuration file. A default filename is provided based on
the meter name, time, and date the configuration was collected. You can keep the
default name or change it. The file is saved, by default, to the Data folder directory
defined under File → Program Settings. You may change the directory location if
desired.

9. Click Print to print the configuration currently opened in the editor.
Only the registers in the currently selected view will be printed. You can also click
the print icon on the tool bar to print the opened configuration.

10. Use Convert to download the configuration from a legacy Rosemount Ultrasonic
meter to later generation of electronics.

a) First connect to the legacy electronics. Collect and save the configuration
using the Tools → Edit/Compare Configuration dialog box. Upgrade the
electronics on the meter.

b) Connect to the new meter electronics and open the Tools → Edit/Compare
Configuration dialog. Open the configuration collected from the legacy
electronics. The Convert button is enabled.

c) Click Convert to read the configuration from the new meter and modify it
with the data from the legacy configuration. MeterLink displays this modified
configuration in the dialog. At this point, MeterLink has not written anything
to the new meter. All the values highlighted in yellow are values from the
legacy configuration.

d) Click Write Checked to write the changed portion of the configuration to the
new meter. If any data point failed to be written, you must correct the invalid
value and click Write Checked again until the configuration is written without
any errors. Once the configuration is written, you can choose to compare
the displayed configuration with the configuration in the meter by selecting
Meter and clicking Compare. This will verify everything was written correctly.

Waveform viewer for transducer waveforms
The speed at which the waveforms update is dependent upon the type of connection
between the PC and the meter. With an Ethernet connection and MeterLink™, several
updates per second are possible. With a serial connection, updates may occur only every
15 to 30 seconds.
Up to three types of waveform signals can be displayed per chord:
• Raw - The sampled waveform received by the transducer (with gain applied).
• Stacked - The result of applying stacking to the raw signal(s). Note that when stacking

is not used (StackSize is set to 1), the stacked signal is the same as the raw signal.
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• Filtered - The result of applying the bandpass filter on the stacked signal. This
waveform is only available when the filter is enabled (via the Filter data point).

For diagnostic purposes, the transducer waveform signals can be stored to a file using the
Diagnostic Collection - Stream to file check box. This utilizes the Rosemount 3810 Liquid
Ultrasonic Flow Meter’s patented “snapshot-and-playback” feature to accurately record the
flow signals that can then be later reproduced for detailed analysis.
Waveforms are displayed in the time domain (e.g., the waveform signal is plotted against
time).

Figure 6-4: Waveform viewer - time domain

The waveforms may also be displayed in the frequency domain. In this mode a Fast Fourier
Transform is taken of the waveform so that the frequency content of the waveform can be
displayed. This can be useful in noisy environments to see the frequency of the noise and if
it is in the range of the transducer signal.
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Figure 6-5: Waveform viewer - frequency domain

Zero crossing and first motion markers
Two markers display along the horizontal axis for either the Stacked or Filtered waveform.
If filtering is on, the markers will be on the Filtered waveform. If filtering is off, the markers
will be on the Stacked waveform. The green marker shows the point where the first motion
is detected. The purple marker shows the zero crossing which is the point that the meter
uses as the arrival point of the signal.

Navigate the waveform viewer
Procedure

1. Select the waveforms to collect from the Meter dropdown menu and click Read.
Selections include:
• All Chords
• Chord A
• Chord B
• Chord C
• Chord D

Note
Chords C and D are available for 4-Path Liquid meters.

2. MeterLink™ starts to continuously stream waveforms from the meter.
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3. Click Save while streaming waveforms or click Stop.
MeterLink opens a Save As dialog box to allow you to choose a name for the
Waveform file. A default name based on the Meter Name, the type of waveform
collected, and PC date and time is suggested. Change the name or default location
if desired. Click Save to accept the file name and save the last set of waveforms
collected.

4. Click Open and select the Waveform filename from the Open dialog box to view a
previously saved waveform.

5. Click Tracking to display the transducer’s raw, filtered or stacked signal Tracking
Parameters dialog for the selected chord.
This dialog displays the parameter’s label, value and units. Some of the Tracking
parameters included are Gain, Hold time, Time (stamp), Maximum Signal Quality,
Peak width, Peak Position, and Peak Zero Crossing for upstream and downstream
signals. These parameters are used in the diagnostics of field conditions.

6. Click Export to save the waveforms displayed to Microsoft Excel® format.
The Microsoft Excel® file contains three worksheets. The first worksheet called
Charts contains charts for each of the waveforms collected. The second worksheet
called Raw Data contains the waveform data to make the charts. The third
worksheet called Tracking contains the tracking parameters for the chord.

7. Click Close to exit the Waveform Viewer.
8. Use Diagnostic Collection set of controls feature to capture a waveform snapshot to

be played back on a simulator. This U.S. Patented feature is useful to allow Emerson
to reproduce any field specific conditions.

a. Click the Stream to file checkbox and wait for the waveforms to start
streaming to the screen. The meter is returning raw waveforms just as they
are received without any stacking or filtering.

b. Click Record to start saving all of the raw waveforms to file. The collection of
waveforms can be paused and resumed without having to start a new file.
Clicking Stop gives you the option to save the data collected to file. The file
will have a .strm extension. There is no utility in MeterLink to playback these
files. The files are only for use internally by Emerson on special diagnostic
tools. Clearing the Stream to file checkbox stops the streaming mode and
returns the Waveform Viewer back to its normal mode of operation.
Important
There is no utility in MeterLink to playback these files. The files are only for
use internally by Emerson on special diagnostic tools.

9. Clear the Stream to file checkbox to stop the waveform streaming mode and return
the Waveform Viewer back to its normal mode of operation.
Note
The file created with the Diagnostic collection grows quite rapidly. Typically when
connected via Ethernet to the meter, the file can easily take up 2.5 megabytes per
minute. If the file must be e-mailed, many mail servers only allow 10 to 20 megabyte
files or approximately 4 to 8 minutes of data.

10. Use the Chart utilities to control the waveform display. The controls for the
waveform chart utility include:
• Scrollbar - enables horizontal and vertical scrollbars on the chart.
• Markers - displays markers for the series in order to see the data points

collected.
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• Zoom In - zooms in on both the horizontal and vertical scales centered on the
cursor.

• Zoom Out - zooms out on both the horizontal and vertical scales centered on the
cursor.

• Sticky - forces the cursor to stick to the waveform trace.
• Other keyboard commands - use the keyboard commands as a shortcut

to access the desired function. Right-click over the chart to display these
commands or enter the keyboard command.

Table 6-2: Waveform chart keyboard commands
Function Keystroke Description
Save State Ctrl + Home Save the current zoom settings. These

settings can be recalled with the Restore
State command. Any saved settings are lost
once the utility is closed.

Restore State Home Restores the last saved zoom settings.
Cursor to Nearest Point F8 Moves the cursor to the nearest point

displayed.
Toggle Coarse/Fine Cursor F4 Toggles the cursor between and fast and

slow moving cursor. The cursor is physically
larger for the fast moving cursor.

Toggle Lines/Markers F9 Toggles off the lines connecting the
collected data and forces on the markers.

Toggle Mouse Position Tip Ctrl+F4 Turns on tool tip showing the coordinates at
which the mouse pointer in pointing.

Toggle Nearest Point Tip Ctrl+F9 Turns on tool tip showing the coordinates
of the nearest data point to the mouse
pointer.

Print Ctrl+P Prints the displayed chart.
Copy to clipboard Ctrl+C Copies the displayed chart to the Windows®

clipboard as table data.
Paste from clipboard Ctrl+V Paste data from the Windows® clipboard to

the chart utility. The data must be in the
appropriate format to correctly paste as a
new series to the chart. Copy data from the
chart to a text file to see the appropriate
format.

Waveform Zoom Ctrl+I Turns on/off the zoom feature while in
Waveform Read or Stream to file mode.

6.1.2  Outputs test
Tools menu
The Outputs Test dialog box allows you to monitor the live values of all the frequency,
current and digital outputs. Additionally, the outputs can be set into a Test mode to
force the outputs to a specific user defined value. This dialog box is only available while
connected to a meter.
Refer to Outputs test mode in this manual for additional information.
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6.1.3  Transducer swap-out
The transducer swap-out utility allows you to update parameters such as path lengths,
delay times, and delta times for chord. This is necessary anytime transducer housings have
to be replaced for a chord.
Refer to the Rosemount 3814 Series Liquid Ultrasonic Flow Meters Maintenance and
Troubleshooting Manual (P/N 00809-0100-3814, Sections 3.3) or the Rosemount 3812
Series Liquid Ultrasonic Flow Meters Maintenance and Troubleshooting Manual (P/N
00809-0100-3812 , Sections 3.6) for detailed instructions for replacing the transducer
housings and setting the parameters for the parts you replaced.

6.1.4  Upgrade program components
Use the MeterLink™ Tools → Program Download dialog to upgrade the program
components in Rosemount Ultrasonic meter. When the dialog is first opened, the
Currently Installed Versions table will show the currently installed program components
in the meter.

6.1.5  Warm start the meter
Selecting this command will prompt you Do you want to warm start the meter
and disconnect from it now? Click Yes to force the meter to restart.
A warm start is the same restart as when power is removed and reapplied to the meter. No
configuration or archive log history is lost. Some configuration changes require a restart of
the meter for the changes to take effect. Click No to close the dialog.

6.1.6  Communications analyzer
The Communications Analyzer is a Windows® application that displays “messages”
transmitted to and received from an addressable device, such as a Modbus slave, by
another Windows® application. The messages are display from the oldest (at the top of
the list) to the newest (at the bottom of the list). The Communications Analyzer date and
time stamps each message displayed. After 4096 messages have been displayed, the oldest
messages are cleared from the list as new messages are added.
The Address combo box filters new messages so that only those with the selected address
(1-32) are displayed. By default, all addresses are displayed. The address filter does not
affect messages already displayed, only new messages.
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Figure 6-6: Tools menu communications analyzer

Procedure
1. Check Browse to disable automatic scrolling. This is useful if you want to look at a

certain message while new message are being added to the list.
2. Click Copy to copy the messages to your clipboard so that they can be pasted into

another Windows application, e.g. Notepad.
3. Click Reset to clear the list of displayed messages.
4. Click Close to close the dialog and return to the MeterLink™ main page.
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A  Conversion factors
A.1  Conversion factor units of measurement

Table A-1: Conversion factor units of measurement
Conversion factor Units of measurement
(°F-32)x(5/9)->°C (°C+273.15)->K
1 K/°C
5/9 °C/°F
10-6 MPa/Pa
0.006894757 MPa/psi
0.1 MPa/bar
0.101325 MPa/atm
0.000133322 MPa/mmHg
0.3048 m/ft
0.0254 m/in
103 dm3 /m3

10-6 m3 /cc (=m3 /cm3 )
(0.3048)3 m3 /ft3

(0.0254)3 m3 /in3

3600 s/h
86400 s/day
103 g/kg
0.45359237 kg/lbm
4.1868 kJ/kcal
1.05505585262 kJ/ BtuIT
10-3 Pa•s/cPoise
1.488 Pa•s/(lb/(ft•s)
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B  Miscellaneous equations
B.1  Miscellaneous conversion factors

Use the following calculations:
• K-factor - A read-only value showing the calculated K-factor from the Full scale

volumetric flow rate used with frequency outputs and the Maximum frequency for
frequency output. This property is disabled if Frequency outputs was cleared on the
Startup Page.

• Vol/pulse - A read-only value showing the calculated inverse of the K-factor. This
property is disabled if Frequency outputs was cleared on the Startup Page.

Equation B-1: Frequency Volumetric Flow Rate K-FactorKFactor = MaxFreq 3600s/ℎr *FreqQFullScale
Equation B-2: Frequency Volumetric Flow Rate Inverse K-FactorInvKFactor = FreqQFullScaleMaxFreq 3600s/ℎr * *
KFactor frequency “K-Factor” (pulses/m3 or pulses/ft3) (Freq1KFactor and

Freq2KFactor)
InvKFactor frequency “Inverse K-Factor” (m3/pulse or ft3/pulse) (Freq1InvKFactor and

Freq2InvKFactor)
FreqQFullScale frequency full-scale volumetric flow rate (m3/h or ft3/h)

(Freq1FullScaleVolFlowRate and Freq2FullScaleVolFlowRate)
MaxFreq maximum frequency (Hz = pulses/s) (Either 1000 or 5000 Hz)

(Freq1MaxFrequency and Freq2MaxFrequency)
(*)TimeUnit: Time conversion factor depends on the VolFlowRate.
• volume/second = 1 s/s
• volume/minute = 60 s/m
• volume/hour = 3600 s/h
(**)Volume: Where the volume is selected via Units System data points.
VolInitUS
• Gallons
• Barrels
VolUnitMetric
• Cubic meters
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C  Troubleshooting communications:
mechanical and electrical issues

C.1  Communications troubleshooting
Q1: Why won't the CPU Module LINK LED turn on when connecting to the meter via the
Ethernet?
A1: The LINK light indicates good electric connectivity between two LAN ports. It also
indicates proper polarity in the Ethernet connection.
WHEN CONNECTING DIRECTLY: Check to ensure that the Ultrasonic cable (P/N
1-360-01-596) cable is properly connected.
WHEN USING A HUB: When using a hub between the meter and the PC, a straight-through
patch cable is required between the meter and the hub and a straight-through patch cable
is required between the hub and the PC. Do not connect either the meter or PC to the hub
UPLINK port. Most hubs do not allow use of the port immediately next to the hub UPLINK
port when the UPLINK port is used to connect the hub to a LAN. Ensure the meter and PC
are not plugged in to a hub non-usable UPLINK port.
Verify that the meter is powered up by checking that CPU Module LED 1 is on (either solid
red or green). If the LED is not on, check power to the meter. If the LED is on, check the
Ethernet cable connections.
Q2: My CPU Module LINK LED is on but I can't communicate with the meter using
Ethernet. What's wrong?
A2: If you are connecting for the first time, refer to Set up the meter directory for
instructions on initial communication (via Ethernet) setup.
If you are using the MeterLink™ program, ensure that the optional Ethernet connection is
enabled.
Ensure that the meter’s DHCP server is enabled (CPU Board switch S2-2 CLOSED). Verify
that the PC has received an IP address from the meter as follows:
• Bring up DOS prompt window (Start|Run|(type)cmd)
• In the DOS prompt window, type ipconfig.
You will then see something like:
• Windows® IP Configuration
• Ethernet adapter Local Area Connection 1:
• Connection-specific DNS Suffix:
• IP Address:192.168.135.35 (note: the last .35 can be up to .44)

• Subnet Mask: 255.255.255.0
• Default Gateway:
If you get the following:
• Ethernet adapterLocal Area Connection 1:
• IP Address: 0.0.0.0
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Then the PC has not yet received an IP address from the DHCP server and you are advised
to wait (up to 30 seconds) to receive an IP address before attempting to connect to the
meter. If after 30 seconds the PC has not received an IP address from the meter DHCP
server or the IP address shown above (from ipconfig) is different from the range of
192.168.135.35 through 192.168.135.44, verify that the PC is configured to receive its IP
address automatically (via DHCP).
To ensure connection to the meter from the PC, at the DOS prompt type:
ping 192.168.135.100 <enter>
• If the meter is reachable, then you will see a message like:

— Pinging 192.168.135.100 with 32 bytes of data:
— Reply from 192.168.135.100: bytes=32 time < 10ms TTL=64
— etc.

• If the meter is not reachable, then you will see something like:
— Pinging 192.168.135.100 with 32 bytes of data:
— Request Timed Out etc.

Q3: How do I connect to multiple meters via Ethernet when they are on the same LAN?
A3: Before connecting multiple meters via Ethernet on a LAN, each meter must be
configured with a unique user- specified IP address (following the initial communication
quick start instructions in MeterLink™ configuration utilities). Contact your IT department
for valid IP addresses for your LAN and Gateway address if required. Once a meter's IP
address is configured, the meter may be connected to the intranet LAN and accessed using
that IP address.
Rosemount 3810 Series meters connected to an intranet LAN must not have their DHCP
servers enabled.
Q4: How do I connect to multiple meters via Ethernet when they are on the same hub but
not connected to an intranet LAN?
A4: The PC may receive its IP address from an external DHCP server; in this case, one and
only one meter must have its DHCP server enabled. This DHCP server will serve up to 10 IP
addresses to PCs attempting to talk to all meters on the hub.
Before connecting multiple meters via Ethernet on a hub, each meter must be configured
with a unique user-specified IP address (following the initial communication quick start
instructions in MeterLink™ configuration utilities). Assign each meter on the hub a unique IP
address within the range 192.168.135.150 through 192.168.135.254. The Gateway address
for each meter maybe left unconfigured as 0.0.0.0. Once a meter's IP address is configured,
the meter may be connected to the hub and accessed using that IP address.

C.2  Mechanical/electrical troubleshooting
This section is meant to assist site maintenance and operations personnel trained in
the operation of the ultrasonic flow meter and knowledgeable in basic mechanical and
electronic/electrical troubleshooting techniques, using laptop computers as well as digital
volt/ohm meters. Exercise great care as to not "short out" a given electronic/electrical
circuit when troubleshooting.
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Table C-1: Mechanical/Electrical troubleshooting
Problem Solution(s)
No power the unit • Check for correct voltage (AC or DC) to the input of the Field

Connection Board. (See Engineering drawings, System Wiring Diagram).
• Check the main power source for blown fuse or tripped circuit breaker.

Reference your "as built" installation drawings for your location.
• Check the fuses on the Field Connection Board. Reference fuse F1 and

F2 locations.

Cannot communicate
with MeterLink™

program

• Ensure that the meter is properly powered.
• Ensure that the computer cable is properly connected to the field

connection board and check your interface pins (RS-485 or RS-232).
• Verify that the communication parameters of the MeterLink program

are set according to jumpers on the meter CPU board. See MeterLink™

configuration utilities of this manual for instructions on configuring
communications.

One or more of the
chords is not indicating
a reading (reporting
zeros)

• Check for loose connections at the cable connectors. See Engineering
drawings.

• Check the resistance of the transducers (Must be approximately 1-2 Ω).
• Problem also may be caused by a bad Acquisition board or

interconnect cable. See Engineering drawings for more information.
• Check system status in MeterLink, Meter → Monitor for any flagged

errors.
• Check the CPU board LEDs.

Waveform contains an
excessive amount of
noise

Increase the StackSize until noise level decreases (settings can be 1 (none),
2, 4, 8, or 16). If increasing the StackSize is not successful, try turning
on the filter or consult with Emerson Customer Support for Rosemount
products if you are unsure of how stacking a signal can effect the meter's
operation. Refer to Technical Support under the Help menu of MeterLink
for contact information.

Connected
communication line to
the flow computer but
no signal is received

• Check for loose connections at the flow meter and the flow computer
(see Engineering drawings).

• Check the CPU Module, Field Connection board and the Power Supply
wiring. Ensure the terminal block wiring and connectors are making
good contact.

Communicating with
meter but all chords
display failures

• Verify that the resistance of transducers is within Specification (1-2 Ω).
• Check the Acquisition board.
• Check the interconnect cables between the base enclosure and the

transmitter enclosure.

Chord is not indicating • Check the resistance of the failed transducer.
• If Chord A is not indicating, change the transducer cables from Chord D

to chord A.
• If Chord D then fails, the transducers are bad on Chord A.
• The same test procedure can be accomplished by swapping Chords B

and C if a chord fails in either chord.
Note
The outside chord cables cannot be exchanged with inner chord cables.
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D  Write-protected parameters
D.1  Write protected configuration parameters

The configuration parameters that are write-protected against changes when the CPU
Board WRITE PROT. switch is in the ON position. The data points in Table D-1 are applicable
for firmware v1.06 and later.
Table D-1: Write protected configuration parameters
AbnormalProfileDetectionLmt
Address
AlarmDef
AO1ActionUponInvalidContent
AO1Content
AO1Dir
AO1FullScaleEnergyRate
AO1FullScaleMassRate
AO1FullScaleVolFlowRate
AO1MaxVel
AO1MinVel
AO1TrimCurrent
AO1TrimGainExtMeasCurrent
AO1TrimZeroExtMeasCurrent
AO1ZeroScaleEnergyRate
AO1ZeroScaleMassRate
AO1ZeroScaleVolFlowRate
AO2ActionUponInvalidContent
AO2Content
AO2Dir
AO2FullScaleEnergyRate
AO2FullScaleMassRate
AO2FullScaleVolFlowRate
AO2MaxVel
AO2MinVel
AO2TrimCurrent
AO2TrimGainExtMeasCurrent
AO2TrimZeroExtMeasCurrent
AO2ZeroScaleEnergyRate
AO2ZeroScaleMassRate
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Table D-1: Write protected configuration parameters (continued)
AO2ZeroScaleVolFlowRate
AsyncEnable
AtmosphericPress
AvgDlyA
AvgDlyB
AvgDlyC
AvgDlyD
AvgSoundVelHiLmt
AvgSoundVelLoLmt
BatchSize
BlockageTurbulenceLmtA
BlockageTurbulenceLmtB
BlockageTurbulenceLmtC
BlockageTurbulenceLmtD
CalMethod
ChordInactvA
ChordInactvB
ChordInactvC
ChordInactvD
City
ColocMeterMode
ContractHour
CRange
DailyLogInterval
DampEnable
DeviceNumber
DI1IsInvPolarity
DitherEnable
DltChk
DltDlyA
DltDlyB
DltDlyC
DltDlyD
DO1AContent
DO1AIsInvPolarity
DO1BContent
DO1BIsInvPolarity
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Table D-1: Write protected configuration parameters (continued)
DO1PairTestEnable
DO2AContent
DO2AIsInvPolarity
DO2BContent
DO2BIsInvPolarity
DO2PairTestEnable
EmRateDesired
EnableExpCorrPress
EnableExpCorrTemp
EnablePressureInput
EnableTemperatureInput
Filter
FireSeq
FlowAnalysisHighFlowLmt
FlowAnalysisLowFlowLmt
FlowDir
FlowPOrTSrcUponAlarm
FODO1Mode
FODO1Source
FODO2Mode
FODO2Source
FODO3Mode
FODO3Source
Freq1BPhase
Freq1Content
Freq1Dir
Freq1FeedbackCorrectionPcnt
Freq1FullScaleEnergyRate
Freq1FullScaleMassRate
Freq1FullScaleVolFlowRate
Freq1MaxFrequency
Freq1MaxVel
Freq1MinVel
Freq1ZeroScaleEnergyRate
Freq1ZeroScaleMassRate
Freq1ZeroScaleVolFlowRate
Freq2BPhase
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Table D-1: Write protected configuration parameters (continued)
Freq2Content
Freq2Dir
Freq2FeedbackCorrectionPcnt
Freq2FullScaleEnergyRate
Freq2FullScaleMassRate
Freq2FullScaleVolFlowRate
Freq2MaxFrequency
Freq2MaxVel
Freq2MinVel
Freq2ZeroScaleEnergyRate
Freq2ZeroScaleMassRate
Freq2ZeroScaleVolFlowRate
FTPServerControlPort
FwdA0
FwdA1
FwdA2
FwdA3
FwdFlwRt1
FwdFlwRt10
FwdFlwRt11
FwdFlwRt12
FwdFlwRt2
FwdFlwRt3
FwdFlwRt4
FwdFlwRt5
FwdFlwRt6
FwdFlwRt7
FwdFlwRt8
FwdFlwRt9
FwdMtrFctr1
FwdMtrFctr10
FwdMtrFctr11
FwdMtrFctr12
FwdMtrFctr2
FwdMtrFctr3
FwdMtrFctr4
FwdMtrFctr5
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Table D-1: Write protected configuration parameters (continued)
FwdMtrFctr6
FwdMtrFctr7
FwdMtrFctr8
FwdMtrFctr9
HighViscosityMethod
HARTDate
HARTDescriptor
HARTDeviceFinalAssyNum
HARTLongTag
HARTMessage
HARTMinNumPreambles
HARTNumPreambleBytesFromSlave
HARTPollingAddress
HARTPressureUnit
HARTQVContent
HARTRateTimeUnit
HARTSlot0Content
HARTSlot1Content
HARTSlot2Content
HARTSlot3Content
HARTTag
HARTTemperatureUnit
HARTTVContent
HARTVelUnit
HARTVolUnit
HighPressureAlarm
HighTemperatureAlarm
HourlyLogInterval
HTTPServerPort
InputPressureUnit
IsAO1EnableTest
IsAO2EnableTest
IsFreq1BZeroedOnErr
IsFreq1EnableTest
IsFreq2BZeroedOnErr
IsFreq2EnableTest
IsTelnetServerEnabled
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Table D-1: Write protected configuration parameters (continued)
LA
LB
LC
LD
LinearExpansionCoef
LiveFlowPressureCalCtrl
LiveFlowPressureGain
LiveFlowPressureOffset
LiveFlowTemperatureCalCtrl
LiveFlowTemperatureGain
LiveFlowTemperatureOffset
LowFlowLmt
LowPressureAlarm
LowTemperatureAlarm
MaxHoldTm
MaxInputPressure
MaxInputTemperature
MaxNoDataBatches
MaxNoise
MeterHousingLength<A..D>
MeterMaxVel
MeterName
MeterSerialNumber
MinChord
MinHoldTime
MinInputPressure
MinInputTemperature
MinPctGood
MinSigQlty
NegSpanSI
NonNormalModeTimeout
NumVals
PipeDiam
PipeOutsideDiameter
Pk1Pct
Pk1Thrsh
Pk1Wdth
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Table D-1: Write protected configuration parameters (continued)
PoissonsRatio
PosSpanSI
PropUpdtBatches
RefPressExpCoef
RevA0
RevA1
RevA2
RevA3
RevC0
RevC1
RevC2
RevC3
ReverseFlowVolLmt
RevFlwRt1
RevFlwRt10
RevFlwRt11
RevFlwRt12
RevFlwRt2
RevFlwRt3
RevFlwRt4
RevFlwRt5
RevFlwRt6
RevFlwRt7
RevFlwRt8
RevFlwRt9
RevMtrFctr1
RevMtrFctr10
RevMtrFctr11
RevMtrFctr12
RevMtrFctr2
RevMtrFctr3
RevMtrFctr4
RevMtrFctr5
RevMtrFctr6
RevMtrFctr7
RevMtrFctr8
RevMtrFctr9
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Table D-1: Write protected configuration parameters (continued)
SampInterval
SampPerCycle
SetXdcrType
SndSpdChkMaxVel
SndSpdChkMinVel
SndVelCompErrLimit
SNRatio
SpecBatchUpdtPeriod
SSMax
SSMin
StackEmRateDesired
StateAndCountry
StationName
SwirlAngleLmt
Tamp
TampHi
TampLo
TampSen
TampWt
TmDevFctr1
TmDevLow1
Tspe
TspeHi
TspeLmt
TspeLo
TspeSen
TspeWt
Tspf
TspfHi
TspfLo
TspfMatch
TspfSen
TspfWt
UnitsSystem
VelHold
VolFlowRateTimeUnit
VolUnitMetric
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Table D-1: Write protected configuration parameters (continued)
VolUnitUS
XA
XB
XC
XD
XdcrFiringSync
XdcrFreq
XdcrHousingLength<A..D>
XdcrHousingSerialNumber<A..D>
XdcrNumDriveCycles
XdcrType
YoungsModulus
ZeroCut
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E  Engineering drawings
E.1  3810 Series Engineering drawings

DMC-004936 3810 Series Ultrasonic Meter System Wiring Diagram
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